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INTRODUCTION PURPOSE AND MAIN FUNCTIONS OF THE PROGRAM
Purpose of the program

The ExperTune program is designed for automated analysis, diagnostics, tuning and optimization of
PID control loops for industrial facilities. The program is integrated with the
APACS+/QUADLOG/ProcessSuite system.

According to available estimates, 75-80% of control loops in industrial plants are more variable in
automatic mode than in manual control mode. At the same time, a third of them, when the load or task
(setpoint) changes, produces cyclic oscillations due to various non-linearities: hysteresis, delay, valve
sticking, non-linearity of the process. About a third more generate cyclic oscillations due to poor adjustment
of the regulators, and for the rest, the cause of such oscillations is design errors.

Modeling of control loops

One of the main and effective tools of ExperTune is mathematical and software modeling of the
technological process and the control loop.

ExperTune provides the ability to dynamically model and simulate the operation of a closed control
system based on the obtained data on the behavior of the control object after a single test impact on the
process. This allows the user to check the effectiveness of the settings recommended by the program on a
closed loop model even before loading them into the PID controller, which is especially useful if the options
recommended by ExperTune do not fully satisfy the user. In this case, he can change the settings offered by
the program himself and check them on the model without interfering with the operation of the real circuit. To
build the model, effective methods of frequency analysis of the results of the response of the circuit to a step
or pulse disturbance at the input are used.

ExperTune automatically selects the most suitable process-load model for your circuit: 1st or 2nd order
process with delay (deadband), 2nd order process with overshoot and delay, integrating the process with
delay.

Automated tuning of PID controllers

ExperTune maximally simplifies and automates the process of data collection, analysis, diagnostics and
optimal tuning of PID control loops directly on the control object. To do this, the user just needs to specify the
control loop and then follow the instructions of the program. ExperTune asks to give the circuit a single
"push” or impulse, and measures the object's response to external influences (change in the SP setpoint in a
closed circuit or a CO control signal in an open circuit). After the end of the transient processes, the program
builds a mathematical model of the technological process using the measured data and calculates the tuning
parameters of the PID controller, which provide the loop characteristics required by the user. At the same
time, the program gives an estimate of the expected improvement in the quality of the functioning of the
circuit with the new settings. If the user approves the recommendations of the program, then the new
parameters can be loaded into the controller and return to the previous automatic control mode. The savings in
tuning time for each circuit is from 2 to 6 hours.

With a DDE/OPC server, multiple circuits can be monitored, configured and analyzed simultaneously.

Stages of diagnostics and optimization of the control loop

Complete control loop optimization with ExperTune includes the following 5 steps:

1. Statistical analysis and diagnostics based on real data of the normal operation of a closed loop in the
system.

2. Frequency analysis (spectral signal density) to detect hidden cycles in the circuit.

3. Analysis of the operation of the control valve to detect and correct defects such as hysteresis and
sticking.

4. Check for non-linearity and linearization of the control loop.

5. Determining the optimal controller settings.



Statistical Analysis and Diagnosis of VValve Sticking

Statistical analysis of the operation of the circuit with changed settings on the model allows you to
evaluate how such process characteristics as standard deviation, variability and load on the valve (intensity of
its movements) improve. The results of the analysis of the real circuit and its model are presented in numerical
and graphical form - in the form of a histogram of the distribution of values of the controlled variable PV.
This histogram is particularly helpful in detecting operating loop defects such as valve sticking, which is often
the cause of poor control and leads to loop cycling. ExperTune calculates a numerical estimate of the degree
of "sticking" of the valve that exists in the analyzed circuit. If the measured valve sticking coefficient is more
than 1%, then its repair can have a great effect - to increase the speed of the circuit and eliminate cyclic
oscillations

Loop Stability Analysis

In addition to the controller settings, ExperTune calculates and displays a graphical representation of the
“region of stability” of a given control loop, which characterizes the degree of stability of a closed loop with
the current settings. The current state of stability of the process in the loop is represented by a point on the
plane in the coordinates X= PG gain, Y= net delay value (Dead Time) in sec. If the operating point lies deep
enough within the stability region, then we can say that this circuit is most likely “stable”, that is, relatively
small changes in the characteristics of the control object cannot make the circuit unstable and cause self-
oscillations.

The dimensions of the "region of stability” depend on the current settings of the PID= controller. Thus,
the stability graph gives the user a graphical representation of the degree of "risk of instability" of the circuit
at a given regulator setting.

Frequency analysis

Frequency (spectral) analysis, i.e. analysis of the frequency spectrum of signal energy distribution, is a
powerful tool that allows you to detect hidden cycles in the operation of control loops, trace and find the loop
that causes cyclic oscillations in the operation of the entire installation, and cross-correlation calculations help
to detect interdependent pairs of circuits.

Frequency analysis also allows you to answer the following questions:

* Has the performance of the control loop improved with the new settings?

* Has the life of the valve been extended?

* Are there hidden loops in the loop noise?

In this case, it is not necessary to test the circuit using the "jump" method of the setpoint or load.

To identify hidden cycles, graphic diagrams of the spectral density of the PV signals and the output of
the CO regulator are used. CO-PV cross-correlation graphs allow you to determine the presence of mutual
influence between two contours.

In order to separate the interconnected flow and pressure control loops, the flow loop must be set up to
be slower than the pressure loop while still providing effective control. The ExperTune program automates
this process based on the frequency analysis of the response of both circuits to the "jump" load. In this case,
special parameters are calculated - the "relative” response time (RRT) of the first and second control loops,
which in the cascade must differ by at least three times.

Longer service life of control valves

Based on current regulator settings, ExperTune determines and predicts valve travel and wear, and then
recommends filters and new settings that will increase valve life.

To do this, the program calculates coefficients that characterize the intensity of valve movements and
the frequency of its reverse (changes in direction of movement) for the current and new (optimal) controller
settings, compares them and determines the optimal filter.

With the help of ExperTune analysis tools, the user can change the PID controller settings and in a few
minutes see how this will affect the life of the valve. Applying a filter to the controlled variable (PV) or
changing the integration time can increase the life of the valve by several times.



ExperTune optimizes the PID and PV filter settings to prolong valve life by reducing valve movement
and reversing while maintaining control quality and loop stability.

A properly selected filter increases valve efficiency between overhauls, reduces operating costs and
reduces noise generated.

After determining the optimal filter type and regulator settings for valve operation, the software
simulates the operation of the loop to make sure that the quality of regulation and the stability of the loop are
not affected.

SP Job Filter Calculation

Typically, the regulator is tuned so that sufficiently fast changes in the output of the regulator will
reduce possible load fluctuations. However, there is often a PV overshoot (bump) effect when stepping the SP
set point. To eliminate this defect, ExperTune calculates the parameters of the lead-lag filter, which is set at
the input of the controller setpoint. If there is no such block in the system, ExperTune gives the user equations
for programming the filter.

With such a filter, a fast response of the circuit to load changes with good control quality is ensured.
The setpoint filter ensures high-quality operation of the controller during start-ups of the process plant and
changes in its operating modes, which is usually accompanied by a change in setpoint values, while
maintaining optimal settings for a normal, stable control mode.

Linearization of non-linear contours

In the case of a non-linear process, the control loop can behave very differently in different parts of the
scale of load values (controlled variable), for example, work stably in one part of the range and generate
cyclic oscillations in another. To eliminate non-linearity, a special software Linearization Unit is usually
added to the control loop in the controller.

The ExperTune program calculates and gives the user all the data necessary for programming the
linearization block in the controller so that the circuit with the found settings works equally efficiently over
the entire load range. Linear-piecewise approximation or hyperbolic function is used for linearization. These
possibilities can be used, for example, for the linearization of flow control loops, secondary (slave) loops of
cascade regulators, as well as in any non-linear loop with a variable setpoint.

Universal unit for linearization of pH control loops

pH controller circuits are non-linear in nature and cycle around the set point. ExperTune linearizes any
pH loop resulting in little or no cycling control. This improves the quality of the product, reduces the
consumption of reagents and helps to keep the pH within the specified limits.

Processes with an inverse response to a control action

There are technological processes that are especially difficult to control, where when the controller
output changes, the controlled variable begins to change in the direction opposite to its required final value.
ExperTune helps to easily model, tune and optimize such processes. In this case, the program automatically
determines the necessary values of the settings parameters - negative lead and integration time constant for
this inverse process.

Contour Optimization and Settings Summary Table

To optimize the control loop, it is often necessary to find a balance - a compromise between the
performance of the loop, its stability and the intensity of valve movements. Changing the PID controller
settings changes how quickly the loop reacts to load or setpoint fluctuations. More aggressive settings
increase performance, but can also increase the sensitivity of the loop to changes in the characteristics of the
control object, that is, reduce its stability. In the ExperTune program, the user can enter the desired “stability
margin” factor, which will be used to determine the optimal settings.

ExperTune generates and stores a summary table of all PID controller settings obtained during its
testing and simulation. This table helps you find the best combination of settings for those "changing™ circuits
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that behave differently as process conditions change. The program analyzes data from several tests and finds
the most suitable, conservative regulator setting, which may be the only one needed for stable operation of the
circuit. Therefore, it is enough for the user to perform several contour tests, and then the program will
automatically generate a table, highlight the most favorable and average values of the settings and parameters
of the contour model. An example would be some unbalanced temperature control loops that respond faster to
heat than to cool. Having ExperTune, it is enough for the user to perform two test “jumps” of the circuit in the
manual mode of the regulator - first in the direction of heating, and then in the direction of cooling. The
program will issue and save the settings for both cases, and the user can choose the preferred option.

Loop Timing Analysis

ExperTune analyzes the ratio of various time parameters that determine the dynamic properties of the
control loop. For example, the polling and data processing cycle in the controller should always be
significantly less than the dead zone of the circuit. If this is not the case, then reducing the cycle time can
significantly improve the performance of the circuit. The following parameters are analyzed and evaluated:

* Data cycle

* Filter time constant

» Differentiation time constant

* Dead zone (Dead time)

* Equivalent deadband (for 2nd order process)

* Integration time

* Relative loop response time (RRT)

Compensatory feedforward regulation

If an external factor is known that causes changes in the controlled variable PV, for example, another
process variable FW, which thus also serves as an "implicit" load on the loop, then a control variable in the
control loop can be calculated that will compensate for the negative effect of changes in FW on the variable
PV. To do this, it is necessary to measure this "influencing™ load variable FW and have a block for calculating
the compensating effect. The ExperTune program, firstly, finds such an “influencing” variable FW and,
secondly, creates for the user on his workstation an algorithm and a program for the Compensator, which is
loaded into the controller and is a program for calculating the compensating control action. The user does not
need to do any additional tests or checks, but can immediately use the received Compensator at the facility.

This control method can significantly reduce the effect of random load fluctuations while increasing
product quality, equipment life and reducing loop variability.

Unstable processes

The ExperTune program works effectively if the constructed model accurately reflects the behavior of
the real control loop. The accuracy of the model depends on the reliability of the data obtained when testing
the object using the “jump” method at the input. To ensure the validity of the data, testing must be performed
with the system in a “quiet” state (that is, without significant load fluctuations) and in the linear range of its
operation. However, these conditions can be difficult to meet in the case of unstable processes subject to
random load fluctuations, or processes that react differently to positive and negative changes in control input.
In such a situation, it is advisable to use more complex modeling and tuning methods with the involvement of
expert engineers from the company.

The program provides the ability to collect and record on disk all the necessary information that can be
sent to the company for analysis and solving complex problems.

Developed reference, information and training system (in English)

In addition to the usual access to information through the Help menu, to call up help, it is enough to
place the cursor on the screen of interest to the image element and press the F1 key.

To invoke the tutorial system, click the "tutorial™ link in the help text or select "tutorial” from the
window menu.



Reports

ExperTune generates a complete report of all operations and results of analysis, tuning, optimization and
diagnostics of each control loop, including all graphical and numerical data, loop performance and setpoint
filter parameters. The report is issued as a Microsoft Word document.

Connecting the program to controllers

The program runs on the Windows NT/2000 platform and interfaces with all common types of
controllers through the available drivers.

The ProcessSuite software package of the APACS+/QUADLOG system fully supports the work with
the ExperTune program. To do this, in the environment of the operator - technologist Vision Framework R5 at
the operator stations of the system, ExperTune is called from the standard window - "PSfaceplate™ of any
control loop configured in the system.

Sources of efficiency in using ExperTune

* The operation of control loops is optimized

* Time savings of 2 to 6 hours per circuit setting

* Improved product quality

* Losses and rejects are reduced

* Energy saving

 Convenient and simple user interface of the program with a developed reference and information and
training system.

Terminology

Variability (Variability) of the contour - Generalized statistical characteristic of the contour, calculated
in the statistical analysis of test data (through the variance of values of the test sample). It characterizes the
average spread of values of the controlled variable at a stable state of the circuit. It can be said that variability
is a measure of the “non-ideal” regulation.

Loop performance is the effectiveness of the control loop in the process, affecting the quality and cost of
production. It is determined by the speed and quality of regulation in the circuit. Ultimately, this indicator is
proportional to the economic efficiency of the circuit.

The test data trend window (“Time data for...”, Time Plot) is a window for displaying, editing and
analyzing contour test data. The trends of PV and CO variables in this window always represent the initial
data that is used by the program for all subsequent calculations and analysis, including the determination of
the mathematical model of the process and controller settings. These trends, i.e. test data, can be edited.

Relative response time of the RRT loop (Relative Response Time) - a relative indicator of speed, the
speed of response of the control loop to a disturbance. The smaller the RRT, the higher the speed, and vice
versa, the larger the RRT, the slower the circuit. This indicator is convenient to use for various tasks of
comparing contours, models and settings.

2. STAGES OF OPTIMIZATION OF THE REGULATION LOOP

Optimization of the PID control loops can significantly improve the efficiency of the control system.
When a loop works optimally, its stability increases and variability decreases accordingly. This ensures
operation in a mode that meets the requirements of the technical regulations.

Loop optimization is not just about adjusting PID parameters.

A typical control loop includes: a process variable, a PID controller, usually a pneumatic-electric
converter, and a control valve. For optimum process control, all of these components must work well.
Therefore, before adjusting the contour, you should check the operation of each of its elements and make sure
that they all work correctly. Regulator tuning is the last step in a complete loop optimization.

With optimal settings, your process equipment will be used at maximum efficiency.

To evaluate the result of the performed contour optimization, ExperTune calculates two generalized
indicators:



 The coefficient of increase in “performance”, the efficiency of the “Performance” circuit (speed and
quality of regulation), which shows how much better the PID controller will work out load disturbances with
new settings. This ratio is directly proportional to the expected cash savings.

 Coefficient (degree) of stability “Robustness” of a closed loop to changes, drift of the dynamic
parameters of the technological process (load), characterizing the reserve of its stability and protection from
self-oscillations. ExperTune statistical analysis allows you to detect and evaluate contour variability

FIVE STEPS TO FULL CONTOUR OPTIMIZATION

1. Statistical analysis and diagnostics according to the data of normal stable operation of the circuit
2. Frequency analysis (signal power spectral density) to detect hidden cycles

3. Diagnosis and elimination of control valve problems: sticking, hysteresis, size mismatch (sizing)
4. Testing of non-linearities and linearization of the contour

5. Determining the optimal PID settings and filter

The following describes in more detail a step-by-step procedure for diagnosing and optimizing your
control loop.

Conduct a survey of operational and engineering personnel about existing problems and comments on
the operation of the circuit. If it is found, in particular, that the circuit is difficult to tune, it should be carefully
checked and diagnosed.

For more information on special circuit problems and their diagnosis, see the "Circuit Problems -
Special Tests, Diagnosis and Recommendations™ chapter of this manual below.

1) Acquisition and analysis of data on the stable operation of a closed loop under normal conditions
(Automatic mode of the regulator).

Obligatory for data collection are normal stable operating conditions of the loop. In this case, you can
check the valve operating range and control efficiency before optimizing the circuit.

It is highly recommended to change the SP controller reference (jump) in order to observe the trend of
the process response (load) before optimization. After changing the SP reference, allow the loop to stabilize
so that process variability can be analyzed.

Use the received data to check that the loop is working under normal conditions:

* The regulator output does not work at the end of the range (0% or 100%);

* The valve does not operate near its seat;

If these conditions are not met, the valve or final control element may need to be replaced.

* There are no cyclic oscillations in a closed loop.

If the circuit oscillates in automatic mode, but is quiet in manual mode, then the cause lies in a closed
circuit. Fluctuations can be caused by non-linear hysteresis or poor tuning.

The oscillations caused by the "sticking"” of the valve have a sawtooth appearance, but oscillations due
to the non-linearity of the circuit can also look similar.

In a linear circuit, cyclic oscillations due to poor settings will be sinusoidal.

The period of oscillation caused by hysteresis increases when the PV variable is close to the SP setpoint,
as this increases the effect of the hysteresis. Data analysis will reveal the cause of cyclic fluctuations in the
circuit.

2) Collection and analysis of stable open loop data. Manual regulator mode

Place the controller in manual mode and collect the PV manipulated variable for a certain amount of
time.

Analysis of the data obtained in the manual mode of operation of the regulator allows you to determine
the range

interference (noise) and variability of the contour in this mode. In addition, signal power spectral
density analysis can help detect hidden loops due to downstream control loops or mechanical problems.

* Carefully check if any periodic perturbations, jumps in the load of the circuit are visible on the trend.
If there are, try to understand where these disturbances come from. Call the frequency analysis function
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(Power Spectral Density of Signals) to help identify cyclic process disturbances. If you manage to eliminate or
weaken them, your regulator will work much better.

Do not rely on the PID controller to eliminate the cycling disturbances caused by the operation of the
preceding loops, unless those loops are sufficiently slow compared to the speed of the loop under test. It is
possible that in order to determine the source of cyclic oscillations, it will be necessary to alternately test and
analyze the power spectral density of the signals of the previous circuits, moving further and further back
along the technological scheme. In this case, on each spectral diagram, it is necessary to look for a power peak
at the oscillation frequency of the original circuit.

» What is the level of noise in the manipulated variable? If the noise level exceeds 3%, then installing a
PV filter can improve the quality of regulation.

Since the derivative term of the PID controller (D) works on the derivative of the PV signal, any noise
in the process in the presence of this term is greatly amplified. significantly improve the quality of regulation.

3) Loop check for hysteresis

The hysteresis check is carried out in the manual mode of the regulator: it is necessary to make several
changes (jump) of the CO output - two steps in one direction and one step in the other. After the end of the
test, the function of data analysis for hysteresis Hysteresis check is launched. If your circuit has more than 1%
hysteresis for valves with a positioner and 3% for valves without positioners, then you should consider
repairing or replacing this equipment to reduce the hysteresis. With a hysteresis value from 1% to 4%, the
performance of the circuit is reduced. A hysteresis of more than 3% at a hard setting of the regulator causes
cyclic oscillations similar in nature to oscillations that occur when the setting is too aggressive.

For more details, see the relevant section of the Guide below.

4) Valve sticking test

To check for valve sticking, in the manual mode of the regulator, it is necessary to make several
successive changes in CO in one direction: one large step and then several small steps. This test can also be
performed as a continuation of the hysteresis test, ie the output of the CO controller is a series of small steps
(0.5% change) in the same direction as the last step of the hysteresis test. To analyze the obtained contour
data, the Stiction check function is called.

The phenomenon of valve sticking is very harmful, much worse than all other possible problems with
the valve. For many technological processes, the sticking value of 0.5% is too high. The presence of sticking
guarantees the presence of cyclic oscillations and high variability of the contour.

For more details, see the relevant section of the Guide below.

5) Checking the linearity / non-linearity of the contour

To check the non-linearity of the circuit in the manual mode of the regulator, it is necessary to make a
series of identical steps-jumps at the output of the regulator at different points in the range, for example, 15%
steps at points 5%, 20%, 35%, 50%, 65%, 80% and 95 % CO scale. After each step, you must wait until the
process calms down. A similar test can be performed with a closed loop by changing the SP setting, but
provided that after each step the loop (variables PV and CO) is completely stabilized in the new state. It is
also necessary to ensure that the test includes a minimum (0%) and a maximum (100 %) valid SP values.

Analysis. Using the collected data, plot the process to determine if the process (loop loading) is non-
linear and to what extent. Find the parts of the curve with the smallest and largest slope. The amount of slope
is equal to the process gain in the given section. The ratio of the maximum and minimum values of the
process gain PG should be no more than 3x, preferably less than 2. If this ratio exceeds 3, then the output
linearizer should be included in the circuit (or the existing one should be modified).

Another way is to analyze the data collected at different points in the CO range using Process Modeler's
mathematical process modeling function. Are the models (or PID settings) very different at different points in
the range? If the parameters differ by more than 2 times, this circuit should be linearized.

If it is not possible to linearize the contour, then it is necessary to use the most conservative, careful
settings in it, which can be found in the Summary table of settings for this contour.

There are PID control loops that split the output range between two (or more) valves. Depending on the
value of the CO output, the regulator works with one or the other valve, switching usually occurs at 50%. For
example, if CO < 50%, the circuit cools the product using cold water or oil after the heat exchanger, and if CO
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> 50%, it heats the product with steam, hot water or heated oil. Usually such loops are very non-linear and an
output linearizer can be very useful for such a loop.

Do not use an output linearizer to correct the non-linearity of pH circuits (pH is an indicator of the
concentration of hydrogen ions) - they need an input linearizer. In such circuits, the method of determining the
Gain coefficient depending on the input variable or error (SP-PV) of the regulator should be used.

For more information about non-linearity and building an output linearizer, see below in the
corresponding section of the Guide.

6) Contour asymmetry check

To control possible asymmetry of the contour, repeat all or the last steps of the previous non-linearity
test (see point 5 above) in the manual mode of the regulator, but in the opposite direction. Check that the
process (load) response is the same in both directions. To do this, you can, for example, compare the PID
settings calculated for one and the other directions.

If asymmetry is found, it must be corrected or more conservative, i.e. less fast, careful settings should be
used.

7) Comparative statistical analysis of closed and open circuit operation under normal conditions.

This step is optional, but very useful. In the Time plot window, on the data trends collected in the
manual mode of the controller, select (zoom in) an area with a normally running technological process, that is,
without unexpected load spikes or test jumps. . Perform a statistical analysis of this data and note the
magnitude of process variability. Repeat the same with the data obtained in the automatic mode of the
regulator, and check if the variability has increased in this mode?

Does the controller improve the performance of the circuit (Performance) or not? Are there cyclic
oscillations in the closed loop (controller setting too aggressive)?

Data for such an analysis can also be collected specifically during quiet operation of the circuit without
test surges.

8) Determine the optimal settings for your regulator

Based on the testing data, the Xtune program calculates several options for the PID controller tuning
coefficients: P, I, D (in the Vision Framework these are PG, Tl, TD), and the F-time constant of the PV filter,
which can be considered as the 4th loop tuning coefficient. These options allow you to find an acceptable
setting.

From the options calculated by XTune, select the setting that corresponds to the most difficult or
“worst” possible case of your circuit: it is either the least aggressive, i.e. slow, setting or the worst process
model, i.e. the model with the maximum delay time DT and the highest gain of the process Gain . To verify
that this is indeed the worst case, compare the actual response to a setpoint change with simulation data

9) Analysis of contour variability with new settings
Collect data on the manipulated variable PV and the output of the closed loop CO controller at steady
state and under normal operating conditions. Analysis. Using the results of statistical analysis before and after

optimization, determine how the optimization affected the variability of the contour. You can also compare
the "before™ and "after" contours using the signal spectral density graphs (Frequency Analysis).
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3. WORK WITH THE PROGRAM AND FILES

This manual deals with the extended (Advanced) version of the ExperTune program with connection to
control loops via a DDE server. The manual is intended for programmers and technologists of industrial
enterprises.

You can work with the program only if the program itself and its license key are installed on the
workstation.

Call from a Vision Framework application

ExperTune (XTune) is fully integrated into the ProcessSuite HMI and is called from the Vision
Framework application via the standard control loop faceplate (Figure 1). At the same time, the working
window of the program (ExperTune faceplate, XT faceplate) is already connected to the corresponding
circuit. In this environment, only one control loop can be operated at a time. ExperTune has its own faceplate
window, which is dynamically linked to the same Vision Framework application tags as the standard
ProcessSuite faceplates (PS faceplate). After calling ExperTune, it is advisable to minimize the Vision
window and proceed to work with the XT faceplate. In this case, the ExperTune window can be enlarged or
fully expanded.
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LAL-612- A
c 18.0,.
10.4,.

29.1.. 2. 9mna 7.9ec

Call via standard faceplate in Vsion Framework operator environment
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EXPERTUNE WINDOW
,{,,\ - = n - .
L ;Ch f left Right choice

i
41 A e View  OpNg > H
iy Enable/disable
- afic001 1 =] "
‘ Gioceed . 2 Edata collection

Wariable Z
| 403 |
Auto scale
Working window-

Software acg|plate XTune
5| Jsimulator (XT faceplate)

u. Doubl!

Apeic A IO TN

Setpoint

B Input Panel

"W meaning
S \ariable. For CO -

only in manual
de.

Regu lator i Display Spans, Colors, Decimals....
operation mode: cale and indication

Auto-machine (IS i " settings panel o e
Manual-manual
2 '

N i 1 5P
Tune from archived data... | AutoTune...

'E Current  New )
E i lle GABC] 2 I Em i Display on graph:{ [v ‘ | t d
M ur P g.sssa L\le?tvi\:] ((;;;ntroller Enginosrng spon: [T [@T——  Coment vake: NI ;g\év selecte

N/A N/ | Display span: |28 54 Decimal places: |1 :II Line
Download Description: [CO Line width: [z = ~ Color..

0K | Cancel | Hew |

Process variable PV - controlled process variable

Setpoint SP - reference, controller setpoint

Controller Output CO - controller output signal

The panel for changing the CO output is available only in the manual mode of the regulator.
Drop down menus:

Archive - enable/disable data collection

View — selection of the layout of the ExperTune window from 3 parts:

« faceplate only,

« faceplate + trend

« faceplate + trend + controller settings indication panel

Options - Setting the data presentation in the window: trends, scales, colors, etc., calling the report

Regardless of Vision, the program is called through the menu: Start - Programs - ExperTune - DDE PID Tuner or
a shortcut on the desktop. In this case, the Vision application acts as a DDE server. Another DDE server is the APACS
Realtime 1/0O Server.

Note: This manual covers only the version of the program designed to work with the DDE server.

During the tuning process, for each control loop, a loop file is created to bind the loop to the XTfaceplate (.tun
loop file). Working with these files is shown below in the figures of this paragraph.
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XTune - DDE

wperTune == =]

3 PID tuner Options  Tukorial
A o Choose a Loop: / Help 3
EEFVOAK tan o [ ) Y e
: New loop... £is —— n -
- "Working with CaTve1_PRLEn v B In|t|a_| window vyork with
= . |]  [fica515 77 _priftun . 5 .tun files connecting
multiple 5 FICAS1S T SEC tun aceplate...
eazie S | XTune to control loops
7= . : e T ] Reference
& Connecting to a new
S'oftv;/are LISt of tun control loop
zsimulator z Ffi
contour files s
regulation Panel for editing the
settings of the binding file
3 i3 . > (- of the selected contour
Calling the XT faceplate o
- B the contour
& 7 td rd = . 3
Test files archive konrypa
e =
Ld tJ td Ld El—

“lw

[
[
[

il

ESp— Calling XTune in a Win2000

g?h

g

Btifiop MpOrpar 1o ymeadanio

=

¥ ascoPID Tuner

&l

Programs »
B FxperTune Database Import

Mporpanms: 5 stertup » 18 HDA PID Tuner

Acrobat Distiler 5.0 T Multi-Loop Dema
AoiyMeHTE! * [} Adobe Acrobat 5.0 HJ rultiple Faceplate Viewer
~ £ Internet Explorer % oPc P Tuner
(el 4] ©utlook Express T P Tuner mannat
Hafith = I simulatio Soﬂware DDE
crparka i - contour simulator DDE server XTune DDE
RO DDE cepsep- anolication program
APACS Realtime pp! PID tuner
P —— I/O Server Vision

linyes || 1 & B || Foe{| Famh. | BRaea..| Flrso I [Wlrsuz I [Hlraz Iﬂ]nsc‘.. Weas...| Gwo...

ar .| Emal...| W@llara..| @Yol | ®edT. | BEExp.. |<ﬁ§l§ LIS @R 114s

Control loop connection files and working with them

& T' CA165.tun - BNOKHOT
m_Me=Ee G s File Options  Tutorial Help
Help=For documentation on ExperTune setup |

files search help for setup file Choose a Loop: Help
[wersion] -

ExperTune DDE Tuner=1g.03.22
common=16.03. 22 _1. New loop._
XPTrend= 16.03.22 T
[ODE]

DDE_sample_interval=1

DDE_Ttem_AutoModeDetect=1

DDE_Item ManualModeDetect=0

DDE_app1i catiomtopi o= VIEW| TAGHAME "

DDE_item_Pv='TICALES-PYV'

E [DDE i tem co= ' TICALES L

DDE_item_sP='TICA1G5-5P"

DDE

DDE 1 tem Derivat]ve=TICALEE-TD

DDE_item_Cantrallertode=TICALES -AM ) = = ® e E-

use_hot_Tinks=1

gggﬁmég:i»}mtamcsﬂ %GFUWU FICAS17_1_SEC.un 2] tc200_t kun
multi afic001.tun TIC210_1.bun

DDE_ScalesP=1

DDE_AEIntegerFile=0 _1sm H| Ty =] TICA1S7.bun

4 [DoE T meoutoso — . =)

=] azfv01_t.bun

Send P Ticarespe 2] Carvoak.un

Send_Integral =TICA165-TI £] C3TVOL_PRLEun PICA413_1_2.tun
g::gﬁss‘e‘:ﬁgﬁgfﬁms’m =] C3TY01_SEC.tun PICA47S.tun TICA178_1_2.tun
DDE_item Filter= M yrie E fica515_1_pritun picad75_ap.tun TICA181_1.tun
gzﬁﬁ;lﬁ;ﬁgpmm c=Simulate | Loop 1 SEChn 3] TICAZ33_Ltun
Read_WriteF Y =] FICAS16_1_PRLtuUR simulateCr.bun
E[Egm:igll TICAL65 contour o ko 2] FicAs1e_t_SEC.tu TIC195_1_1.tun
g [sp12m n-4tfbinding file to XTune .
EAS?lS’é’ﬂ?’:;Z (.tun file) y | Wrn panina [Ticatss iun Oepens |
e Tun gaiinoe: [ setup fles (o) M/
Linestyle=solid 4
% |01 splayOnGraph=1
InstMin=0
InstMax=100
[Channel2]
EngMin=0
a0 —— - - :
Eé,_;mm._wzz S A text file with the extension “.tun” (“.tun loop file”, for example, TICA165.tun) contains all
BEEIES?E}QEEE(‘;E’ he necessary information and settings for establishing communication and operation of the
Eme?tﬁgeEs;mhgl program (and faceplate) XTune (DDE PID Tuner) with the TICA165 control loop.

mrztnihg By default, .tun files are located in the D:\...\Xtune\dde folder, but during the creation process
[Focamrolier 1eop 11 |lthey can be grouped into other folders inside ...\dde using the SaveAs... “Save As...”
mntrn]1e§$tng:s:mans, unction.

gnﬁ?uerﬁv:l The same folder contains archive files of completed tests of each circuit connected to the
escription=Facep]ate

Puchanne] -1 program, for example, TICA165.001, TICA165.002.

h. 1= . .
oo gtz 0 connect a new circuit, for example TICA200_1, you must:
integral_units=1 . . o ”» £ aye T
PE_multip]ier=1 1) create and save in the specified folder a new “.tun” file by editing one of the existing ones

Integral multiplier=1

perivative mitipiier=2 ||(for example, TICA165.tun) using the Edit Panel shown in the following three figures, or

ComtrollerSamplelnterval =

InyerseProcess=0 2) it is enough to call once and then close the Xtune program from the Vision Framework

P [FilterUnits=Same As D

[Trend] application through the standard PS contour faceplate, for example TICA200_1. In this case,

NumberOfChannels=3

[Trend0ptions] he corresponding tun file is automatically written to the ...\dde folder.

UsersetDispl ayRanges=0

DOE_ScalePVandCO=0
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List of .tun

contour files

regulation

XTu

ne

start window,
contour gfic001 selected

ontour file edit panel

Help

ExperTune OIF Line Analysis & 'ID Tuning

Options  Help

=10 =] Setup for

r Contraller options

Controller: [Siemens. APACS PID

Proportional Band or gain [Gain =

Units on Integral [or reset] [minutes/iepeat =

Path to the outline file

gfic001

Advanced... | Save | SaveAs . (Close | Deceplate ...
——

r DDE

Click on data to tune:

File name

afic001.005
afic001. 004
gfic001.003
gfic001.002
gfic001.001

Test archive
contour gfic001 | patete

Collected

Edited
10/02/05 02:39
09/28/05 03:50
08/27/05 05:26
09/27/05 02:33
09/27/05 01:49

Time plot |

Loop Hotes

Replacer. |

¥ Use hot links ¥ Unique wiite loca
Application|topic [Simulatell oop

Sample Interval [0.5 (seconds)

sp [SPData T| PBforgain [P T
SP to send [SPDataWrite Integral |1 T
PV [P¥Data 1|/ Derivative D T
€O [COData Mode |ControlletMode T
COto send [CODatawite A Auto Mode: [Auto [Manual:[Manual | Mare modes

- Controller and Process Variable span
[~ Scale P¥ and CO

Ctil. Dutput Eng. Span:
Process Yar. Eng. Span:

Items to send
PB to sem
Integr to sem
Deiiv. to sen

Mode to send

d P
L
d D

ControllerM ode

Change Notes

File  Options Tutorial

Choose a Loop:

HelpDoc

Help

Connection of a new
circuit (tic200_1), i.e.
creating a new .tun file by
editing the TICA165
contour file

Edit

Apnei

;nr

— afic001

Process
Variable
39.7

Controller
Output

Current New

Fiew Options  Help

14:36:35 14:36:59 14:37:23 14:37:47

Tune from archived data.._

AutoTune... | close |

2 N/A
0.5833 | [N/A

0 [nin

NiA | [NsA

Download

Faceplate...

na

New loop

cuit by editing

Experiune

PY Enginesting units [m3/%

CO Engineering units [ |

Editing panel with settings
or connecting XTune to the
ofic001 circuit.

the new loop.

€ This is the first loop to be tuned on this contioller. There is not an
above setup wizard to select. This selection will lead you thiough setting
up pour first loop and will create an ExperTune wizard to help you set up
subsequent loops.

" Use thef Siemens APACS (Single Loop) | wizaflig set up 0K

& Hianngliy st up e new oo from the Edi Sk window:

redit panel

Connect a new path manually using the

\

Nankar |3l dde =l o+

cf B

Cancel
Help

i

ki ofich01 eun
2] azrFvnl.tun
a2fv01_L.tun PICA390_1.tun TICZ10_1.tun
'Z] carvosk.tun

2] catvoi_PRLEuR
=] CaTY01_SEC.tun
] ficas15_1_pri.tun .
2] FIcAS1S_1_SEC tun pica475_ap.tun mcontours
'Z] FICAS16_1_PRI.Eun
2] FICAS16_1_SEC tun
2] FICAS17_1_SEC.tun

TIC195_1_1.tun
tic200_1.tun

gficap_azfv01.tun

PICA409_1 tun TICA1S7 bun
PICA413_1_1.tun Te|_jst

PICA47S.tun

simulap.tun me(tun files)
simulate.tun TICA178_1_2tun
[Z] T1ca181_1.tun

[Z] simulateor. tun

%]

Setup for D:YProgram

PICA413_1_2.tun :Efconnected

TICA233_

|

r€¢ua nax ’ [ic200 1.1un < | Dcapane |

Tun daiina: setu files [* tun]

Help | Advanced... | Save | SaveAs ... | Close | Eaceplate |

Orrena I
7

i

r Controller options

— Saveas ...

(Contraller: [Siemens. APACS PID

Units on Integral [or reset]

When the Controller Dutput goes up, the Process Yariable goes [up  ~| |

Propoitional Band or gain |Gain x

P

minutes/repeat x

Setup Wizards... I D multiplier |1

~DDE

Replace

—
¥ Use hot links [~ Unigue wnilanalinns ===

ic [VIEWITAGNAME

SP [TICA165-5P

N mple Interval (0.5 [seconds]
x| 5 o gen e e

Integral |TICA165-TI

PY [TICA165-PY L TICA165-TD
CO [TICAT65-VL |7] Mode [TICA165-AM
Auto Mode: [1 Manual: [0
r~ Controller and Process Variable span—————— PV Engineering units
[ Scale P¥ and CO CO Engineering units
Min. span Max. span

Chl. Dutput Eng. Span: [0 |
Process Var. Eng. Span: _

Replace all : ITII:M 65

in DDE item names

with : |TIC200_1

Cancel | Help
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File Options Tutorial Help

Choose a Loo,

Mew lonn

TICAT65.tun ew outlin
Sy

tical65+ tun Eun oewp..

Faceplate. ..

Off-line. ..

A 4
" Use the| Siemens APACS (Single Loop]

the: news [Honeywell Alcont
. . |Honeywell TDC3000 via GUS
€ This s yfisybisi MC2
above sdodicon
Up your f Sie s (PRI Cascade]
EC Cascade)

& Manuallf™

wizard to set up

e is not an
u through setting
help you set up

Selection of system
g\s “Mand type of

=
7]
Trend

oK |
Cancel
Help

Help | Advanced . |

SaveAs . | Close

| Eaceplate __

r Controller options

Controller: ISiemens, APACS PID

Proportional Band or gain Iﬁain 'I

Units on Integral [or reset] |minutes/repeat =

Wwhen the Controller Output goes up, the Process Yariable goes Iup j

-

P

1 mul

Setup Wizards.__ I D

~DDE

¥ Use hot links

" Unique write locations

Replace... |

Applicationltopic [VIEWITAGNAME

Sample Interval [0.5 | (seconds)

SP [TIC200_1-SP 7]

PV [Tic200_1 |7

PB or gain (TIC200_1-PG
Integral [TICZ00_1-TI

TIC200_1-TD

N

- —
co [ficzonave | )
Checking 7

Mode |TIC200_1-AM

T
T
T
T

Auto Mode: [1 [Manual:[0

rControfles and EDDE spal
I Seals P¥ acommunica

Process Yar. Eng. Spai

PV Engineering units
CO Engineeting units

Testing Item: CO

Tes

Test passed
DDE Item name: Tl\successfu"y
Raw Instrument value - |74 612388610¢

Refresh time [ms) - 500

Scaled engineering value - _
Decimal places : [T = Units - [PCT

s |

More modes
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LA% DIFFERENT DDE SERVERS

de’\ TICA157.k

Help | Advanced.. | Save | Saveas Close | Eaceplate ...

File Options Tutorial Help

Choose a Loop:

ok Help — Controller options
picad75_ap.tun =
simulap.tun Mew loop... Controller: ISiemens, APACS PID
simulate. tun P iplier [1
?'ﬂ':';lggeq":l,‘:c T ediLs When the Controller Dutput goes up. the Process Variable goes [up | | Luiiplier [T
TIC210_1.tun Proportional Band o gain | Gain = Setup Wizards. . | D multiplier [1
Units on Integral [or reset] [minutes/iepeat | Controller Sample Interval [0.5 [seconds)
List ~DDE el Gl 10 it locati |
se hot links nique write locations
connected. TAGNAME - snepl‘lmfm 1[0.5 d
it 3
COﬂtOUI’S 5 ; ample Interval | | tseconds)
(tun files) o d 157-5P |T| PB orgain [TICA157-PG T
y Integral [TICAT57-TI T
F¥ [TicAT57-PY [T|  perivative [Ticats7 1D T
CO [TICAT57-VL [ Mode [TICA157-AM T
Auto Mode: [1 [Manual:[0 More modes
r Controller and Process Variable span——— PV Engineering units
[~ Scale PV and CO CO Engineering units

Min. span Max. span
Chil. Dutput Eng. Span:
Process Yar. Eng. Spa

Setup for
File Options Tutorial Help |

SaveAs .. | Close | Faceplate

Choose a Loop:

® | Controll

Controller: ISiemens, APACS PID -
P 1
When the Controller Output goes up, the Process Variable goes [up =] | iplior [1
Propartional Band or gain [Gain = | Setup Wizards... 1

Units on Integral [or reset] [minutes/repeat |7

~~_APACS I/O

~DDE

se hot links | Unique write locations Replace... |
Apgficationltopic [APACSIDBTASERVICES Sample Interval [0.5 | tseconds)

Test successful

“BL601.REGULENT.TICATG| 7| B of gain [RSUT BLEOT REGULG01 TICATES CON T
E ltem name: RSU1.BLEDT REGULED1. TICAT - = Integral [RSU7 BL601 REGULGO1 TICAT65 CON T
FSUTBLGOTAEGUL 6) - TICATG[T] Derivative |RSU1.BLG01.REGULE01 TICAT65.CON T

Raw Instrument valus : [50. 004855257 CO |RSU1.BLE01.REGULEOT TICATE| T | Mode |RSUT.BLE0T.REGULE0T. TICATE5.AUT T

Auto Mode: [1 [Manual: [0 More modes
 Controller and Process Variable span——  PY Engincering units [rpaaC__ |
Relresh time (ms) : [500 Bl St ) e 80 gmneering unt's (7
cale PV an €0 Engincering units & |

span Mazx. span

oF
Scaled engineering value : EOUIEN Ctrl. Output Eng. Span:

Decimal places : [1 = Units : [rpaaC (it e (E: Fmeie

_ e | vision Application

[e LIS@AEE 156

Archive  Wiew Options Help

- sim-101
Process
Variable

frchive Wiew Options Help

- sim-102 =
Process P =] span |
v,

Controller
Dutput

PY 5P

uto -

Current  Mew
50

N/A

Ps0 |

1 35 N/

D 0 N/A Controller
F

N/ | [NA At

Download

Archive Wiew Options  Help

~sim-7418 =
M Pracess [r =l [ | |

Variable
2

Archive  View

~sim-103
Process
Variable

Controller
Output

10:44:05 10:44:25 10:44:45 10:45:05 10:45:25

Tune from archived data... AutoTune... Close

i The number of faceplates on the screen is
basically unlimited. Dutput
395 ]

Controller

o]

Trend

16



Faceplate for TICA157
hive View Options Hslp

- PICA475
| Process
Vo

Yariable

It is assumed that all contours are
already bound to Xtune and are

present in the list of .tun files, — S—
1st way:

Controller

conwallerJo RUN the required DDE servers

(VisionViewer, APACS I/0, .
PSP c Simulate Slmulator) in minimizeds o 18:59:35 18:59:59 19:00:23 19:00:47
m state o

Tune from archived data... | AutaTune... | Clse |

Curient Hew - i Cuirent New
5 » Call a separate instance of the Xtune ® 3 ®
o p me” | ks ExperTine
o Do A program and open the faceplate > ] i
W | F [N NA for each |00p F [N/ | [mra
Download Download

Faceplate for TICA165
hive Wiew Options Help

=10l x|

aceplate for gfic001 _ o =

Archive  View Optians  Help

. ~TICA165 =
= - = -
afic001 puaces o | — = Focese | Ca— R = [ =]_sean
ariable = P
45.2 62.96
—= o
Aoy i = e Setpoint
PrintH ;‘&E 630 |
Controller Contraller Er—
Output D - e |
|43 ] oy
9 | 4 =
7l by 5p co 18:59:34 18:59:58 19:00:22 19:00:46 PV SP co AR 18:59.58 15:00:22 19:00:46
i Bute - Tune from archived data... AutoTune... |  Close | o Tune from archived data... | AutoTune... | __Close |
Current _Mew
Curent  New ® =
P 5.3 N/A
1 == ExperT ExperT
UCl D [0.033 | [0.033 D [0.021 | [N/A
F|o 0 F [N/ N7A
Download | Download

4x faceplates work independently
o] 5 @ 21 8 |] B0 oo | Ba| An. v Al | Ao AWl pu.| g 1; | s @*_IE_IE_I@_IE_I

[Ee LI@AER 120

Fle Options Help

= : 3

Select a loop :

| = d: [Program]

Working with the —
‘Z4 Program Files

group display program = Progr ,
faceplates . o heatgar
multiple face plate
Viewer option A

| < e

=

ceplate for Lic200_1

archive  Visw  Options  Help

- tic200_1 e

[ =Faceplate for TICA178

s Archive  View Options  Help
Yariable ~TICA178_1_1 =
36.70 Fiocess ] ] _pan | o

Variable
5812

Selpoint
7

Controller
Output

A

72,3 Controller
- Dutput aceplate for TICA16S
Pv SP oo 13:51:12 13:51:36 Archive View Optons Help
Butoe - Tune from archived data... | o A e
Cumrent Hew m Tune from ai Variable
P 588 =
- - — N/A
2nd way: [ [W7a
H H H N/A
Use the Multiple Faceplate Viewer (MFViewer) HE=

program to call and work with several faceplates. |[micad
There are 2 options here:

A. In the MFViewer program window, select
from the list
the desired contours (with the CTRL key pressed)
and click the Start Faceplate button with the
mouse.

B. Open the folder D:\...\Xtune\dde with .tun
contour files, select the desired files with the
mouse (one by one or several at once) and drag
them with the mouse to the Start Faceplate button
in the MFViewer window.

Controller
Output

PV 5P 13:51:12 13:51:36 13:52:00 13:52:24

uto -

Tune from archived data.._ AutoTune. . |  close |

Experlune®

Current  Mew
5.3 N/A

P
1 011 N/A
D [0.021 N/A
F |N/A N/A

Download
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| [JFac- plate Viewer

File Options Help

Select a loop :

[ = d: IProgram]

DA
‘3 Program Files
1 ProcessSuite

Bl

MaFin  Mpagka BWa  MsBpadHoe  Cepewc  Cnpaska
EHaag + & - 2] | Bnowe [Fynaen (B[ 05 05 K = | E-
Aapec: |@ dde j @ Mepexon
1CAS16_L_PRIEN

Maris X

(] Pabiownii cron

@ Mok ADKYHMEHTE

= @ Mo KoMMEHTER

28 Aok 3,5 (A0
[#= Syskem (C)

-3 Program (D)

£ mssaLr

=1 Program Files
(1 Pracesssuite

prese
imulz

|»

2] C3FVO4K.bug

FRI.0O1
H

IZ] caTvO1_PRI.TUN

[ 20 |

Controller

1 Ralback
L2 sent =] fica515_1_pribun
: S tend |2 FICAs1S_1 sECo0t [
2 Temp . Vanable
[ Archive (E5) Zl IC, N

M/,
M/
M/

[

Download

B Komnarr-anor (F1)
[S‘ﬂ MaHenks YNDAENSHHA had
[Beiaeneno ofbexTos: 2

Display Program
Faceplate Multiple Faceplate
Viewer Option B

14:33:00 14:33:24 14:33:48 14:34:12

Tune from archived data... AutoTune... | Close |

Experiunes

New
M/A
0.5833 | [N/A
0 M/A
N/A M/A
Download

Current
2

P

1
o ] D
o) v
Trend

101

Note. If you select the menu Options - Always on top in the “Faceplate viewer” program window, then this

window will always be on the screen in front of all called faceplates. This is convenient if you need to call faceplates
sequentially one after the other.

When a faceplate is closed, XTune remembers the content and position of each faceplate on the screen.
XTune also has the ability to create path shortcuts that immediately bring up the faceplate of the desired path.

This also provides work with a group of contours.

The number of called faceplates on the screen is in principle not limited
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Software contour simulator Simulate
XTune has a software PID loop simulator for the main types of technological processes

= al 1

m
The circuit is
requlated Choose a Loop: o

PICA+13_1_2 tun ~
39.75262 @

Simple Control Loop Simulation v 16.03.1
© 1994-2006 ExperTune Inc
File Options Tutorial Help

PICA475 tun Hew loop... |
pica475_ap.tun —_—

Mode: tic200_1.t

‘ ode: [a| Ticz1n 1.'.'
P [50.0 ]

||

‘ D m

|

Faceplate for simulate

Archive  View Options  Help

=151 | - simulate = [eo =l e

Simple Control Loop Simulation v ‘ 5
© 1994-2006 ExperTune In Variable 52 units

[ Process type
Flow. simple [slow)
Flow. non-linear
Flow. non-linear. hyst.
Flow. non-linear. stict

oo

-

\

\

e |

‘ \

\

\

\
el e o e ha ke

(Erdhizd Flow. non-fin. stict, hyst =
SP- [40_] p— Level
39.25618 @ CO: 36.86236 40 = Temp. (Non-linear)
Mode: [ = pH [Non-linear) Controll
i o =] = rmoter
| . EEEN
| Type of simulated L 26 units
| PV SP 18:51:33 18:51:57 18:52-21 18:52:45
process
| 1.C ti imol uto ¥ Tune from archived data. .. AutoTune |  Close |
.( Ions)ump ion simple e 7_ o
Slow, PR |[Na E me
Piocess Lﬂﬂd—‘ 2. Flow is non-linear | (05837 | IN7A ( i
[Tolal load size: [0_] _+5% | 5% | . Do [Nza
3. Non-linear flow rate, F [Na_|[N7A
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Additional trends and contours in the XT faceplate window

To the main control loop (Faceplate loop), which is represented in the XT window of the faceplate by trends of
three variables: PV, SP and CO, you can add additional trends for a number of other variables (“Additional_trend”), as
well as additional contours (“Additional_contour” object). Further, these objects are displayed, tested, their data are
recorded in the archive and analyzed together with the main contour. There are many examples where other processes
need to be monitored while testing a loop for tuning and analysis. These are, for example, cascade control,
interdependent circuits, proactive compensation control, etc.

IFor each loop connected to XTune (ie in each .tun file), up to 64 additional trends can be created. But only the
trends you need are called up for indication in the faceplate window.

In addition, many additional contours can be created from variables for which additional trends are defined for
tuning and analysis.
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Configuring Additional XT Faceplate Trends

In the Edit Setup main loop (.tun file) window, click the “Advanced” button. Then, in the panel that appears, click
"Extra Trends" to call up the Setup Extra Trends panel for defining and configuring Extra Trends.

This panel is empty on initial call. To set the first Add Trend and then the following trends, click the Add Trends
button. Each Sub_Trend must be given a unique name (Description), DDE information to link to the variable, scale
information, and trend indication parameters in the XT faceplate window. Trend display parameters can also be set
directly via the faceplate.

The names PV, CO, and SP represent the main loop variables and cannot be used for Sub_Trends. After you have
finished configuring the trend, you must click the Test button to check that the trend is correctly defined and linked.

All additional trends are archived to disk and can then be used for tuning and analysis in the same way as main
loop trends.

If a loop with additional trends has archived .tun files, then you will no longer be able to delete or rename existing
trends or change their DDE links to XTune. This restriction allows you to preserve the integrity of the data in the
archive.

If you need to change existing trends, then you must either delete all archive files of the current contour, or create
a new contour using the SaveAs button (Save under a new name) in the Edit Setup editing window.
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Creating an additional contour

Each contour name (.tun file) in the list of the initial window of ExperTune represents a certain number of archive
files that contain data of both the main contour and all Additional_trends and Additional_contours configured for this
contour.

To create the main loop, the Edit Setup editing window is used, but the Additional loops are configured using the
special panel (window) Extra Loops Setup. To call this panel, in the Edit Setup window, click the “Advanced” button,
or in the “Offline” archive file window, select the Options menu and then Loop Setup.

To create any Aux_loop, you must assign its variables: PV (manipulated variable), CO (controller output) and SP
(Reference), with PV and CO being mandatory, and SP may be absent. In this case, the names of real variables that play
the role of PV, CO, SP are taken from the list of Additional_trends. In addition, for each Additional_loop, the name of
the loop, the type of controller, and the direction of the process reaction to the controller's action are indicated: direct or
reverse.

Thus, Additional_contour is a named pair or triple of variables PV-CO-SP .

In the Extra Loops Setup window, select the desired loop from the drop-down list at the top of the window. Here
you can add or remove Additional_contour.

The main contour (Faceplate loop), which is indicated in the title of the XT faceplate window, can also be
selected, but cannot be changed. You can only make changes to this circuit in the Edit Setup window.

Enter a new name for Subloop, then select and checkmark the two or three variables that make up this loop as PV,
CO, and SP.

Operation with a cascade control loop

In a cascaded circuit, the output of one (primary PRI) regulator serves as a reference for another (secondary SEC)
regulator. In order to avoid interaction in the cascade, the mutual influence of two circuits, the external (primary) circuit
must be at least 3 times slower than the secondary circuit.

The response time of the loop depends on the controller setting 1 (TI) - the integral time constant and is
characterized by the RRT (Relative Loop Response Time) which is calculated from the loop analysis. The RRT of the
outer circuit must be 3 times greater than the RRT of the inner (secondary) circuit. If this requirement is not met, then it
is necessary to reconfigure the outer loop so that its RRT is 3 times greater than that of the inner loop. In addition to
RRT, the performance of the loops can be estimated from the values of the I (TI) tuning parameters.

To set up a cascade, first set up the internal loop in local mode (with open cascade). Then switch to cascade
mode and adjust the outer loop.

Procedure for testing and tuning cascade circuits:

» Set the internal (secondary) circuit to local mode LOCAL (cascade open, SP reference entered manually).

» Test the internal loop and collect PV and CO data as described in the relevant section of the Instructions.

» Load the settings calculated by XTune into the secondary PID controller.

» Set the secondary (inner) circuit to cascade mode, in which the reference/setpoint input SP of the inner circuit is
connected to the controller output of the external (primary) circuit.

* Test and collect PV and CO primary loop data. The controller output serves as a reference for the secondary
circuit.

» Compare the values of the integration time I (T1) obtained during tuning for the primary and secondary circuits.
The value for the outer (primary) loop in units of time/repeat (min/repeat) should be 3-4 times greater than that of the
secondary loop. If this is not the case, increase the value of the primary loop integration time so that the required ratio is
met.
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XTune has a cascade simulator software to help users with difficult cascade circuits. Using the software
simulator, it is possible to tune both circuits of the cascade at the same time.

Testing and tuning two cascade circuits with one test

This possibility is based on the use of the software simulator ExperTune.

The secondary (internal SEC) circuit is tested and simulated in the usual way: PV data and the output of the CO
regulator are collected. However, for an external (primary PRI) loop, the process model is found by using the secondary
loop variable PV instead of the primary controller output.

The cascade jump test can be performed on both the primary and secondary circuits. At the same time, it is
necessary to ensure that data collection begins and ends with a stable state of the controlled variables PV of both
cascades.

Procedure example:

» Connect ExperTune to the secondary loop of the cascade and create an additional trend for the PV variable of
the primary (outer) loop.

* Test by applying a test "jump" to the secondary circuit. Collect and write to the archive data of the secondary
circuit (PV, CO) and the variable PV of the primary (external) circuit. In this case, the primary circuit should work
normally, and its controlled variable PV should be in a stable state at the beginning and at the end of the data collection.

» Create an additional loop from two variables: PV of the primary and PV of the secondary loop, where the PV of
the secondary loop replaces the output of the primary loop controller. Name the resulting additional circuit "Master
Process" (Primary process).

Perform (Tune) the calculation of the settings for the Master Process circuit, then click the "Analysis" button to
identify the process-load of the primary (external) circuit, that is, to build its mathematical model. The secondary
(internal) circuit is the load for the primary circuit regulator.

* In the next step, select the previously obtained secondary circuit test file in the archive and call the calculation
of settings (Tune) for it, and then perform the analysis. After analysis, in the window of the mathematical model of the
process “Process Model”, in the list Model type (Model type), select the item “Start Simulator With This Model” (Start
the simulator with this model). This calls up the XT control loop simulator and its settings window.

* In the XTune simulator window, click the “Cascade Loop” tab and enter the primary (external) loop process
model obtained in the previous step. Then open the “Controller” tab and select the appropriate controller for the primary
process. Now the simulator has obtained the program model of the cascade.

* Next, in the simulator window, select the secondary circuit and calculate the PID controller settings (PID
Tuning). The loop simulator will automatically calculate your secondary loop controller settings for a given
combination of process model and controller. As a rule, for a secondary circuit with a safety factor equal to 1, one
should not use “load tuning” settings, which are primarily designed to work out load disturbances. It is recommended to
set a stability factor of at least 2.5 for the secondary circuit.
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* Click the “Master Controller” tab and call “PID Tuning” to tune the primary loop. Then select the desired

setting option in the presented “PID Grid” table.

» Review the analysis results for variable response trends and cascade stability plots. Try to explore possible
options on the resulting model according to the principle “What will happen to the cascade if ...”.

Cascade setup example
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4. Testing and data collection for analysis, diagnostics and adjustment of the control
loop

Data collection requirements for testing

Requirements to ensure optimal PID settings, reliable simulation and analysis contour

1. Data acquisition of the controlled variable PV and the output of the CO controller must begin and end with a
stable (calm) state of the circuit (and the process) according to the principle:

Steady state - fast change (PV or CO jump) - new stable state.

Especially important is the initial phase of data collection in a calm state (before the jump).

You can finish testing within 5% of the stable state

Testing includes a jump in PV or CO. In the automatic mode of the regulator during testing, the SP reference
(setpoint) is changed, in manual mode, the output of the CO regulator.

A stable state means that the controlled variable PV and the output of the CO controller are both stable, their
trends are horizontal lines that can deviate from a straight line no more than within the limits of the “normal” noise,
interference of the control object. In this case, it is not necessary that PV=SP.

If there are noticeable changes in PV, CO or cyclic fluctuations, then this is not a stable state. Random,
unreasonable disturbances, load spikes also do not provide “good” data for tuning and analysis.

The normal noise for a given loop is small changes, disturbances in the controlled variable PV, not caused by the
regulation itself. This "noise" is due to electrical noise, electromagnetic interference, turbulence in flow control loops,
possible waves in liquid tanks, etc.

2. During testing, the loop load must not change, there must be no random disturbances, abnormal bursts of the
controlled variable PV, otherwise the data obtained will be bad. With such perturbations, PV begins to change before the
regulator output, and the program will incorrectly evaluate this data as an infinite gain process. The test data scale should
be as linear as possible. For example, applying a pneumatic signal to a valve to create a “jump” will not give good data
for adjusting the regulator, as it will not have a jump itself. Change the SP instead or put the loop in manual mode and
jump the CO output.

In the case of ""noisy"" circuits, the collected test data, i.e. the changes in the PV variable caused by the test, should
be about 10 times greater than the maximum amplitude of the noise fluctuation (peak to peak). The same applies to
changes in the output of the CO regulator.

What is a Load (Process) Upset?

This is a change in the process that is not caused by a change in the SP controller setpoint, an external influence
that causes the controlled variable PV to deviate from the SP setpoint under conditions of stable normal operation of the
loop. A sign of load perturbation is that PV starts to change before CO (see figure below).

Examples:

Flow Control Loop — Pressure variation downstream.

Level control by output flow - an increase in input flow will disturb the load.

Another example: steam is injected into a stream of cold water for heating, as a result, the temperature of the cold
water at the inlet of the apparatus changes.
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3. If your circuit is unstable or cyclic, try the following:

* Set the circuit to manual regulator mode and wait for it to calm down.

« If the loop cannot be switched to manual mode or drifts in this mode, then in automatic mode enter a low PG
(typically around 0.2) and wait for the loop to stabilize.

4. For the best performance of ExperTune, filtering of the controlled variable PV should be excluded. If the
system uses a filter, then XTune will remove the filtering at your request, provided that the Un-filter option is selected
(No filter).

5. Interval of data collection during testing. The ExperTune program analyzes pairs of PV and CO values read at
a certain frequency. Data collection should be performed at an interval equal to the regulator cycle or 4-10 times less than
DeadTime - the equivalent dead time (dead zone) of the regulated process. This interval is measured in seconds and is
also used to update trends and charts.

It is usually considered optimal when the reading interval is equal to the cycle of the regulator in the controller. The
interval (regulator cycle) on the one hand must be short enough compared to Dead Time (DT) so as not to introduce
additional delay into the circuit, but on the other hand, not too small so as not to overload the controller. The DT value is
the time it takes for PV to start changing after a change in the regulator output.

In the APACS+/QUADLOG system, the regulator cycle is equal to the controller scan cycle.

It is recommended that the data collection interval be 4-10 times less than the process lag time, otherwise the
quality of analysis and tuning is reduced. For example, if the data reading interval is close to DT, then by reducing it by
only 2 times, you can double the efficiency of the loop. By default, the program suggests making this interval equal to 0.1
Dead Time. If the interval does not meet the requirements, the program will issue a warning message.

Data compression. XTune uses a maximum of 1025 value pairs for analysis and tuning

data. If the collected test data contains more than 1025 pairs, then the sample read for analysis is compressed to
1025 pairs. The user can assign a different limit. In principle, the program can read up to 1 million points, but it takes
several minutes to read large amounts of data.

A very high quality of tuning can already be achieved with a data volume of 200 to 500 pairs of values, and large
samples are not necessary.

Typical PID Loop Test Procedures
1. Regulator in manual mode (open loop):

a) Verify that the output of the CO regulator is not in the 0% or 100% state, or in another "saturation” limit state.

Otherwise, set the output to an intermediate state between 5% and 95% (or bring it out of saturation). The valve in the
limit state usually becomes a non-linear element.
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b) Wait until the circuit calms down and goes into a stable state. Enable data logging (archiving).
¢) Quickly (jump) change the controller output by about 10%

d) Wait until the controlled variable changes (works out) by a sufficient amount, then return the CO output to its

previous state. This step can be skipped if your technology object is known to respond well to setpoint changes.

e) Wait for the circuit to calm down and go into a stable state. Turn off data logging.

Changing the CO output in the manual mode of the regulator
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Changing the reference (setpoint) SP in the automatic mode of the controller
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2. Regulator in automatic mode (closed loop):

This test is carried out similarly to the previous one, but instead of the output, the reference (set point) of the SP
controller is changed abruptly. (Fig. 3)

The test is usually faster if the integral term of the PID controller is removed. To do this, in the controller settings,
the integration time constant T1 must be made as large as possible, i.e. TI=4000.

3. Regulator in automatic mode and a quick manual jump at the CO outlet:

a) Verify that the output of the CO regulator is not at 0% or 100% or other saturation limit state. Otherwise, move
the output to an intermediate state between 5% and 95% (or take it out of the limit state). The valve in the limit state
usually becomes a non-linear element.

b) Wait until the circuit calms down and goes into a stable state. Enable data logging or archiving.
c) Set the regulator to manual mode and quickly (jump) change the regulator output by 5-10%

d) Immediately return the regulator to automatic mode

e) Wait for the circuit to calm down and go into a stable state. Turn off data logging.

4. Quick test for slow circuits - controller in manual mode:

This test is performed by applying a double pulse to the output of the controller, which can significantly speed up
the acquisition of data on the controlled variable, especially for slow loops with a large delay. When testing, a stopwatch
or timer is required.

See fig.1 and 2.

a) Verify that the output of the CO regulator is not at 0% or 100% or other saturation limit state. Otherwise, move
the output to an intermediate state between 5% and 95% (or take it out of the limit state). The valve in the limit state
usually becomes a non-linear element.

b) Wait until the circuit calms down and goes into a stable state. Enable data logging or archiving.

c) Set the regulator to manual mode and prepare a stopwatch or timer

d) Quickly jump the controller output by 10%. Turn on the stopwatch.

e) Wait for the controlled variable to change (work out) by an amount much greater than the noise level in the loop,
and then jump the controller output in the opposite direction and by an amount twice as large as in the previous (d) step,
i.e. by 20%. Also, note the time T elapsed since the first jump and start the stopwatch again.

f) As soon as the time interval T has expired, return the controller output to its original state, which was in step b
(Fig. 1).

g) Wait for 2T time and then stop data collection.
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Quick test for slow loops. Regulator in manual mode.
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AUTOMATIC TEST PROCEDURE
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MANUAL (SEMI-AUTOMATIC) TESTING
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Some diagnostic messages when collecting loop data
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KEYS AND FUNCTIONS OF THE INITIAL DATA TREND WINDOW

Calculate new PID settings from the trend data presented in the window. After that, when the “Tune”
/y key is pressed, the controller settings are automatically recalculated with each change, editing of the
trend-graph by the user. Pressing the key again cancels the automatic recalculation.

-Select and increase a part of the trend-chart as the initial data for calculations.

Return the original Trend (after the Zoom in command).

. Remove the effect of the PV filter, if it exists. For calculations and analysis, ExperTune
requires source data without a filter.

/Average. The specified portion of the data is averaged.

|Graph editing. A sequence of trend points can be replaced by a straight line segment. This will,
“for example, remove random noise peaks, etc.

PV filter. It analyzes how the data trend will look like if a PV filter is applied to the contour.

5 ¥ &% &2 Y O 8

Undo the last change of the chart with the Averaging, Trend Editing or Filter commands.
Return the original trend view.

‘Statistical analysis. The mean, standard deviation, and variance of the PV data are calculated.

-
Ead

* The histogram shows the statistical dispersion of the PV data.

|Checking the circuit for hysteresis. Prior to data collection, a special test must be performed.

. Sticking test. The amount of valve sticking is determined. To collect data, a special test is
needed.

*Linearizer. The linearization block of the non-linear contour is calculated.

. XY chart. A graph Y(X) of the dependence of the variable PV=Y on the output of the
controller CO=X is built.
| «Spectral density. A graph of the distribution of the spectral power of the PV signal is

“*  constructed, which makes it possible to determine any cyclic components of PV.

«Cross-correlation. A graph is constructed that determines the presence and degree of
interdependence of PV and CO data.

»Master of the integrating circuit. Very slow "integrating” contours are analyzed by taking the
derivative of PV.

«Pivot Table - a log of circuit settings, where are recorded various options for ExperTune settings
for a given contour.

g Settings and analysis report. A complete report of the analysis and contour settings is generated
-as a MS Word document.

Bl » =2 &5 F

=l S

[

ExperTune uses exactly the same data that is shown in the Source Data Trends window ("Time data for:") for
tuning calculations and contour analysis. If the editing command Zoom, Edit line, Average, or Undo changes the

trend in this window, then the program, using the mathematical model of the process, will automatically recalculate

all PID settings and contour characteristics for new initial data.

The path name of the data file used is written at the top in the title of the window. The Source Data Trends window

can be moved to any position on the screen. Closing this window is similar to pressing the Done tuning key and
ends the session of analysis and calculation of contour settings.

34



Editing collected data

The initially collected test data (test sample) is presented in the Data Trend Window by a real trend graph, , which
can then be edited by the user. Editing is aimed at improving the "quality” of the initial data for subsequent calculations
and may include:

» Selection of the part of the trend with "good" data (Zoom in)

* Averaging some data (Average)

» Smoothing of individual sections of the trend to eliminate, for example, random peaks and noise.

The sequence of trend points can be replaced by a straight line segment (Edit0

* Elimination of the influence of the PV filter (Un-filter), etc.

Use the Zoom in function to select in the Trend Window and then zoom in on the smallest patch of test data that:
1) Starts when the loop is stable. (Very important)
2) Ends within 5% of steady state. Use the Average and Edit functions to edit the data.

Zoom In (Select and enlarge)

Place the mouse cursor on the first point of the data section you want to use and click the left button. Then select
the last desired data point with the mouse and left-click again. In this way, the plot of the data trends for the new window
will be determined on the timeline. After that, by clicking near the left or right edge of the selected area, you can stretch it
to the left or right, respectively.

Click Zoom now to finally select the highlighted data and get a new window with data trends. The number of
points used for analysis must be at least 33 and not more than 1 billion.

Zoom Out — Return full original image

Zoom Back to Previous — undo the result of the previous Zoom In command (you can only go back one step)

Auto Zoom — attempt to automatically select the best data for setting calculations

Average — Averaging part of the data in the Trends window. The function is called from the Edit menu

WARNING: Averaging changes the collected real object data.

The selection of data for averaging is done using the cursor in the same way as the selection for the Zoom In
function. To cancel, use the Undo option or the Cancel key.

Line Edit (Straight line editing)

This function allows you to replace a sequence of points (trend section) with a straight line segment or a broken
line, which is useful for removing noise peaks and other random data. You can edit even a single point.

The rubber band line function is used to select and edit data.

Data collection for loop stability analysis

o For a number of analysis tasks, such as statistical and frequency analysis of the contour, information is needed on
the stable normal operation of the circuit without jumps in SP and CO. The data collection for this case is
different from the tests to calculate settings. The necessary data can be obtained here in the following way:

o + When the loop is stable, collect data again specifically for analysis using a semi-automated procedure with
manual data acquisition on and off.

e « Using the Zoom In option, in the Trends Window, edit the information of the archive file of one of the
previously performed tests of this circuit, selecting for analysis the desired section of data on the stable operation
of the circuit.

Industrial test data examples

The figures show real test data, as well as some examples of selecting a section of the trend or editing the collected
data in order to obtain “good” data for calculating controller settings and analysis.
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Example 1: Collected data trends have cycles and random noise peaks.

Recommendations. Before using this data to calculate settings, you need to:
1. Select the area of data trends highlighted in dark color using the Zoom in function.
2. Remove noise peaks by editing.
3. It may be worth doing a power spectral density analysis of the signal to find the cause of the cyclic fluctuations.

Example 2. The process responds to the control action in one direction faster than in the other - process asymmetry.

Recommendations. Select in turn (Zoom in) the two shaded data areas shown in the figure and obtain for each
value of the controller settings. Use a more conservative setting. To calculate the most conservative settings, use the Loop
summary table.

5. SETTING THE REGULATOR. CALCULATION OF PID SETTINGS AND FILTERS

The sequence of steps for setting the controller

STEP 1. Connect the XTune program to the control loop via the DDE server. When calling XTune from the PS
faceplate in the Vision Framework application, this connection occurs automatically.

STEP 2. Testing and collecting loop data:

* to enable the automatic procedure, click on the XT faceplate button AutoTune Sequence (Auto tuning)

» when using the semi-automatic procedure, data collection is turned on and off manually (on the XT faceplate).

After collecting the information, by clicking on the “Tune from archived data” button, you can call up a list of
archived test files for this circuit. Select the desired file and click the “Tune” button (Calculate controller settings).

After the end of the automatic tuning procedure or after selecting the archived data file and pressing the Tune key,
the Trend Window “Time data for...” appears on the screen with the data saved in the archive in the form of trends, and
the faceplate shows the current settings and new values of the controller settings calculated from these data, including
filter time F.

36



STEP 3: View and, if necessary, edit the test data presented in the Trend Window, which ExperTune will use to
calculate settings.

Zoom in, Edit, Average and Filter functions are used to edit data. In addition, on the faceplate in the "Controller
tuning" zone (Regulator settings panel), you can select the desired setting option - with a focus on the best development:

* load disturbances Load tuning (3 options: the fastest Fastest, just fast Fast or relatively slow Low)

» Changes in the task (setpoint) - Setpoint tuning or its variety Lambda tuning.

Any changes made to the data in the Trend Window automatically cause XTune to recalculate and display the

new PID settings. Thus, the data in the Trend Window is always the initial information used by ExperTune to analyze the
contour and calculate the controller settings.

STEP 4: Download new settings to the regulator with the Download button.

About the method of calculating PID settings by ExperTune

To determine the best mathematical model of the process and calculate the PID settings, ExperTune uses the
frequency response analysis method and an expert system.

First, the program converts the initial data presented in the Trend Window into the frequency response of the
process (frequency response and phase response). This is why the original data (collected during testing and possibly
edited) must start and end at a stable loop state. Thanks to this characteristic, ExperTune can tune the circuit based on the
results of only one step jump or impulse in automatic or manual control modes.

The frequency response of a process uniquely represents and identifies that process. The quality of the
characteristic and the PID settings calculated on its basis depend on the quality of the initial primary data. Random load
disturbance reflected in this data distorts the frequency response. Let, for example, you used such data. But with such a
perturbation of the process, the controlled variable PV changes earlier than the output of the CO controller. Therefore, the
gain of the Gain process on the frequency response will tend to an infinitely large value, since PV has changed, and the
change in CO output is zero.

ExperTune then runs an expert system that finds the best settings and process model. 8-10 options (categories) of
Pl and PID settings are calculated, including PV filters.

It is often asked, does ExperTune use the Ziegler-Nichols method? Our “Load tuning-fast” (Quarter amplitude
damping) option is closest to Ziegler-Nichols, but the fastest (optimal) “Load tuning-fastest” option is better than Ziegler-
Nichols. ExperTune recommends using this setting.
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Regulator setting
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Controller Tuning Panel

The controller tuning panel (highlighted by a frame on the faceplate) opens together with the call to the PID
settings calculation function: from the faceplate or the Trends Window by the “Tune” button; through the Options menu
in these windows; when closing the Trend Window.

The ExperTune program calculates the P,I,D controller settings and the F filter time from the initial data presented
in the “Time data for:...” Trends Window, taking into account additional parameters/requirements on the Controller
Tuning Tuning Panel.

Initially, the program offers its typical version with default parameters. Usually this is the option shown in the
figure: “Load tuning — Fastest”. The values of the new recommended settings are presented in the New column on the
faceplate, and the used additional parameters are presented in the Controller Settings Panel.

In the general case, on this panel, a variant (category) of settings is selected and additional requirements and
parameters are set, which ultimately determine, together with the test data, the type of regulation and the values of the
recommended settings calculated by ExperTune.

Possible choices include:
* Type of control algorithm - P1 or PID, that is, the use of a differential component (derivative control)
o « Safety factor of the loop
* Options for settings with a focus on better compensation of load disturbances (Load tuning) with different
performance or optimal response when changing the SP task (Setpoint tuning)
e« Use of PV filter and its type

ExperTune finds several settings that are optimal for different types of regulation and their applications. All these
tuning categories (10 options) are presented in the Table of recommended tuning options “PID Tuning Grid”, which is
called by the PID Grid key.
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The desired setting option is selected in the “drop-down list” in the box under the PID Grid key, and in the Table
itself, the selected option is highlighted with a frame. See the next paragraph for an explanation of the options.

The values of the P, I, D, F controller settings, calculated and selected according to the requirements of the request
on the Controller Settings Panel, are shown on the faceplate in the New column (New settings) to the left of this panel.

With any change in the query on the Settings Panel, as well as when changing the source data in the
Trends Window, the settings values are recalculated and updated.

Regulator setting panel
Current (Current) and [ ST AHanus e

new (New) controller . | r Controller Tunin
settings Imtﬂ "l Anal_ru:l 9

Current _New PID Grid I Done tuning | End of setup
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Safety Factor (SF) — Margin of stability, stability, a coefficient that determines the degree of stability of the circuit
to changes in the dynamic characteristics of the load / process. SF can take values not less than 1, by default SF = 2.5.

Use derivative if possible — if possible, use the differential component (derivative control).

If this process is not necessary or harmful, then the zero value of the differentiation time constant D = 0 is set.

Find PV Filter - find the PV filter. The filter type is selected in the drop-down list. For more information about
the PV filter, see the dedicated section of the Guide.

Un-filter the PV — remove the PV filter action.

Loop Summary — summary table (log) of contour settings.

Add to Table — add setting to PivotTable (log).

If the parameter is not available or not applicable in this category of settings, then the designation N/A is put.

Done tuning — end of controller setting.

Download — load the new settings into the controller.

Probable Performance Increase — potential improvement in loop efficiency/performance.

Comment. The filter time constant F can be considered as the fourth tuning parameter, and we can talk about PIDF
(PIDF) settings.

When to Use Derivative Control.

The use of derivative control (D) allows a greater use of proportional (P) and especially integral (1) action, which
can result in a much faster response of the circuit to disturbances (see figure). second order processes such as temperature
control, but can also improve the step response of most other circuits.

However, D should be used with caution. If D is too much, it makes the circuit unstable, if it is too small, it does
nothing, but it can cause the valve to “jitter”, increasing its wear. The ExperTune program ensures optimal use of the
differential component D.

Recommendations:

» Don't use D with processes where almost all of the delay is pure dead time.

* Be careful when using D in "noisy" circuits, as D can amplify noise. This is where a PV filter can help.

* Always take into account the possibility of increasing valve wear due to D and make compromises.

* If the regulator does not limit the action of the derivative, then D cannot be used.
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An example of applying the differential component D: blue - PI, red - PID
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Loop performance is the effectiveness of the control loop in the process, affecting the quality and cost of
production. It is determined by the speed and quality of regulation in the circuit. Ultimately, this indicator is
proportional to the economic efficiency of the circuit.

Performance Increase — Increased circuit performance/efficiency

This indicator (PP) depends on the speed of the loop, the speed and accuracy of regulation and allows you to
evaluate how better the PID controller with the new PIDF settings responds to load (process) disturbances. It is used for
comparative analysis of contour settings.

If the circuit is optimally tuned, it has minimal variability and can work closer to the set target, in accordance with
the regulations and with less loss of resources.

PP is an estimate of the probable relative (in%) increase in control efficiency under load disturbances, calculated
from the integral absolute control error IAE under the assumption that both at the "old" and "new" settings there is no
overshoot due to load disturbances.

In the case of overshoot, the Rl becomes a “rough” indicator, approximately proportional to the improvement in the
integral error IAE. However, even so, it remains a reasonably good tool for measuring and predicting the "performance”
of a circuit.

Usually this figure is directly proportional to the amount of money that can be saved using the new settings. With a
"bad" setting, an accidental perturbation of the load in one direction can lead to a violation of the production schedule and
a decrease in product quality. Changing the load in the other direction will require additional costs of expensive materials
or energy in order to keep production within the technological boundaries. Therefore, the optimal setting will save
resources with the required product quality.

For example, adding MTBE to gasoline increases the octane rating. But it's an expensive additive and you want to
add just the right amount to get the right octane rating. Adding less is prohibited by the regulation. Therefore, it is
necessary to adjust the additive flow rate as close to the target as possible. This possibility is provided by the controller
setting, which provides the minimum value of the accumulated (total) absolute error IAE.

Find PV Filter — find PV filter of given type

The filter type is selected in the drop-down list.

The program will calculate the largest possible filter of a given type (filter time F) for the selected PID setting so
that it does not significantly reduce the efficiency of the loop.

Through the Edit Setup window for editing the parameters of connecting the loop to ExperTune, you can set the
filter time unit; Edit Setup - Advanced - Loop Setup - Advanced. If Same as D is selected, then the filter unit will be the
same as the derivative time constant D of the controller.

You can not only use the recommended filter, but also try to enter your own filter time - current or new. Transient
response trends in the Control Loop Simulation — Setpoint (- Load upset) simulation windows and Robustness Plots are
instantly updated to reflect the new filter type and size. In the Control Loop Simulation —Measurement noise response
window, you can also analyze the effect of a filter on noise suppression and valve wear reduction.

The PID Grid loop settings options window contains all the filters recommended for each setting category.

IMPORTANT NOTE. The initial data for ExperTune used in modeling, analysis and calculation of controller
settings must be collected without a filter, otherwise all data will be distorted.

The filter can be removed automatically using the special option Un-filter the PV (Remove the PV filter).
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For more information about the PV filter, see the PV Filter in the Control Loop section below.

Un-filter the PV (Cancel PV filter)

This powerful feature gives the user the ability to see and use the raw raw PV data before filtering it. Thanks to this
option, you can even collect filtered data for analysis, and then instruct XTune to remove the filter. For accurate and
correct modeling, analysis and calculation of PID settings, the program needs “clean” data without filtering. But
sometimes it is more convenient to collect and archive PV data with a filter. Then ExperTune automatically removes the
filter and presents the user in the Trend Window with primary data without filtering, providing conditions for more
accurate calculations.

The type of filter used by the Un-filter function is shown on the faceplate in the "PV Filter" dropdown box. It can
be one of the 4 types discussed earlier in this section of the Guide.

In order for the filter to turn off automatically, on the XT faceplate, in the "Controller Tuning" area of the Settings
Panel of the controller, above the Loop Summary button, select (check) the "Un-filter the PV" function. You can also use
the option of the same name in the Edit menu or the key in the Data Trends Window.

The current value of the filter time F is presented in the column of 4 current controller settings “Current P,1,D,F”. If
the current value of F is read from the controller, it is shown on a gray background. The unfiltering function uses the
value of the filter time that was at the time of data archiving, which may differ from the current value.

The value of the filter time constant used by the Un-filter PV function can be viewed by placing the cursor
(without clicking) on the corresponding key in the Trend Window.

Comment. The "Find PV Filter" option is a calculation of the recommended filter value, and the "Un-
filter PV" option is a completely different, independent function.

Table of recommended PID settings

This table shows all the recommended loop settings calculated by the program from the initial data of the Trend
Window for PI and PID control in 5 typical categories with different requirements for speed and control accuracy and
loop stability.

Loop tuning parameters include 3 Pl and PID control parameters and a PV filter, which are calculated in units
accepted by the controller or system to which XTune is connected:

P — proportionality or gain factor (in the APACS+/QUADLOG system, denoted PG),

I — integration time constant in time/repeat time units or inverse units (in APACS+/QUADLOG this is Tl in
minutes),

D- derivative time constant in the same time units as the integral factor I (in APACS+/QUADLOG this is TD in
minutes).

Filter(F) - 4th setting parameter - PV filter time constant. The unit of time for the filter can be set in the loop setup
(binding) window Edit Setup-Advanced-Loop Setup. By default, this unit is taken equal to the unit of differentiation time
D.u

Each setting option is additionally accompanied by the value of the RRT parameter (relative loop response time in
seconds), which characterizes the speed of the loop.

If a certain parameter is not used in this category of settings or is not available, then N/A is put instead of its value.

In this window, the user can also change several general parameters: Safety Factor, PV filter type, etc. When the
window is closed, the settings recalculated after these changes are shown in the "New" column.

Terms and Definitions

Conservative control, conservative settings - careful, "soft", relatively slow control with a focus on ensuring the
stability of the circuit.

Aaggressive, hard settings, regulation - focus on fast regulation and maximum loop performance

Customization options by category
Load tuning — “For load” settings provide for most circuits optimal regulation and compensation of disturbances,
load surges of the controller (process). For this category, the program calculates 3 options that differ in the degree of
aggressiveness of regulation:
e Fastest — the fastest
e Fast- quick
e S|owW — MeJIeHHBIN
Setpoint tuning- settings "For working out the task™, are intended primarily for optimal regulation of the process
with changes in the SP task.
Lambda tuning- "lambda" settings, a kind of settings "for working out the task".
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Settings for better compensation of load disturbances Load tuning

For most circuits, ExperTune recommends using Pl or PID control with the fastest (Fastest) setting option "For
load", that is, Load tuning - Fastest. This is the most difficult to regulate and at the same time the most common case, in
particular, integrating processes and lag processes with delay.

An example of a load disturbance. Level control in the tank with a control valve at the outlet. In this case, the
change in inlet flow is a perturbing change in the load of the regulator

A sign of disturbance in the load of the controller (process) can be the appearance of a seemingly unreasonable
change in the controlled variable PV in the absence of changes in the SP reference or the output of the CO controller, and
the change in PV begins earlier than the change in CO.
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In practice, when choosing settings, there is always a compromise between the speed of the circuit and its
sensitivity to changes in the dynamic parameters of the controlled process (proportionality factor Gain and Dead time).
Usually the fastest setting option with a low stability coefficient is at the same time the most sensitive to changes in the
dynamics of the process. On the contrary, the contour with the slowest settings and the highest degree of stability is the
least sensitive, that is, more stable.

Example of loop response to SP setpoint change before and after "'Load fastest™ setting
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Influence of the safety factor on the settings "'For load" - category Load tuning

The SF factor allows the user to control the stability of the loop at settings in this category. In other categories: "To
work out the task" (Setpoint tuning) and "Lambda" (Lambda tuning), this role is played by the time constant of the
transient response of the circuit Response (lambda) time.

The default stability factor of SF=2.5 gives a conservative setting that satisfies the requirements of the technology

in most practical cases. To get faster loop response, enter SF< 2.5. With SF = 1, the fastest reaction is obtained, but
without a margin of stability.

With the safety factor Safety factor =1, the following options for the settings "For load" are obtained:

Version Control characteristic at SF =1
Fastest ..........  The best option is the minimum absolute error during a load jump
Fast:

Quarter-amplitude vibration damping (the amplitude of each subsequent half-cycle of the transient response
is approximately half the amplitude of the previous half-cycle)

Slow:; Overshoot 10%

With SF=1, the settings are very sensitive to small changes in process dynamics (gain and net deadtime). It must
be borne in mind that most control loops are somewhat non-linear. Therefore, in the general case, for loop stability, non-
linearity compensation, and overshoot reduction, a coefficient SF > 1 is required

and fairly conservative settings.

Overshoot problem

Overshoot (PV exceeding the SP setpoint when the loop responds to load or reference surges) depends on many
factors, including process dynamics and non-linearities, as well as the cause of the change - load or SP reference.

In the general case, in order to eliminate overshoot at the “For load” settings, it is necessary to reduce the integral

action of the controller by 3 times. For example, if the integration time constant | (TI) is in minutes/rep, multiply | by 3,
and if in reciprocal units, divide by 3.

Using the Setpoint/lambda tuning option usually eliminates overshoot due to load disturbances.
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Settings that provide optimal processing of task changes - Setpoint tuning

This option is also called “Lambda tuning”, that is, these two terms are synonymous. In the Table of settings
options window under the name “Lambda tuning” there is an additional option of settings “For task processing”.

In this category, instead of the Safety Factor, the parameter Response time (Reaction time) in seconds is set - the
time constant of the first order transient response PV when the SP reference is changed. This parameter determines the
speed of the circuit when processing a new task, as well as the degree of its stability. For a faster response, set the time
constant to a smaller value, and for a slower response, to a larger value.

The settings in this category are calculated in such a way as to ensure the operation of a closed loop with a total
reaction time, which is the sum of the process delay time found by the program (Dead time) and the specified reaction
time (Response time). The response of the circuit to a change in SP is first delayed by the Dead time.

For most circuits, ExperTune recommends the Load Tuning — Fastest setting with Pl and PID control, but if you
need to eliminate the possibility of overshoot, you should use the settings of the Setpoint (Lambda) tuning category.
Therefore, this type of setting is popular in a number of industries where operators - technologists do not want to work
with overshoot.

By default, the software sets a "conservative" response time value that is large enough to ensure that there is no
overshoot when the SP reference is changed. To get the most "dense™ and fastest processing of the task in this category of
settings, reduce the initial value of the time parameter by 3 times.

Disadvantages of the Setpoint tuning category:

» there are no settings for circuits with an integrator

* no PI settings for 2nd order process control, although most of these processes have PID settings in this category.

For integrating circuits, you can apply the Lambda tuning variant - see the next paragraph about this.

Standard "'Lambda tuning -Lambda tuning

This option also belongs to the category of settings focused on optimal processing of the SP task without
overshoot, and is consistent with the tuning practices used by specialists familiar with the “lambda” control method.

At the bottom, under the settings column, there is a small field “Lambda”, where the lambda type of the controlled
technological process is selected:

1. Lag rule - 1st order process with gain Gain and pure delay Dead time

2. Intg rule - integrating process in combination with Dead time delay

If these attributes are not applicable to your process, they will not be available in the window.

With the Lag rule flag selected, this setting option is the same as the Setpoint tuning setting, except that the initial
(default) Lambda time value is usually greater than Setpoint Response time.

Quality of Frequency Data Fit - an assessment of the quality of the original data used to calculate the settings.

The optimality and efficiency of the settings calculated by the program depends on the quality of the initial data
presented in the Trends window.

This score gives an overall assessment of how smooth, free of interference (noise), correctly collected, and reliable
your loop data is. The indicator can take the following values:

excellent - excellent very good - very good good - good fair - satisfactory poor - weak, not enough

questionable - doubtful very questionable - very doubtful

Questionable data quality means that the resulting PID settings are most likely unreliable and should not be used.

ExperTune evaluates the quality of the initial data by the amplitude (frequency response) and phase (PFC)
frequency responses of your process (Bode plots), and this assessment shows how close the mathematical model found by
the program coincides with the real frequency response.

The frequency response, on which both curves: AFC and PFC - amplitude and phase, gradually decrease with
increasing frequency, gives the best indicator of data quality. The better the source data, the better the frequency
response.

How to improve data quality

* Check the data in the Trend Window for compliance with all requirements.

The acquisition of both PV and CO data must begin and end with a stable loop condition, and be sure to collect a
sufficient amount of stable data first. See the relevant section of this manual for details.

* Verify that the collected data is not the result of two different tests with an extra jump of the SP reference or CO
output.

» Sometimes it is possible to improve the data by editing it in the Trend Window: select a trend section with “good”
data; remove random peaks; smooth out excessive noise, remove the "bad" part of trends (see Zoom In and other editing
options)
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« If during testing there was a disturbance of the load (process), then it is necessary to collect all the data again,
taking into account all the requirements.

» Don't use the PV filter to improve data quality - it won't help. Adding a filter to the loop will lower the crest factor
by a factor beyond the filter time, but will not reduce the fluctuation of the curve. If the filter is large enough, then the
program, in addition to the process, will also try to tune in to the filter

* There are contours that do not produce high quality data at all.

Even very good data quality does not guarantee that optimal and high-quality PID settings will be obtained. The
following questions should always be considered: 1) Does this reference data represent the full operating range and
operating conditions of the loop? 2) Does this data belong to the same contour that you are setting up?

Sample interval - Interval (period) in seconds for cyclic operation of the controller and calculation
of the output signal using the PID algorithm.

The cycle (period) of the controller should be small enough not to introduce a noticeable additional delay of the
“dead time” type into the circuit, but not so much that an overload of the controller or a decrease in the accuracy of the
PID algorithm calculations could occur.

For optimal operation, the cycle of the regulator (controller) should be 4-10 times less than the delay time of the
regulated process (process dead time).

The term Sample interval is also used to refer to the interval of contour data collection by ExperTune. To obtain
reliable data and build a sufficiently accurate process model for analyzing and calculating PID settings, this interval
should also be 4-10 times less than the process delay time. Therefore, it is best, optimally, when the data collection
interval for ExperTune is equal to the cycle time of the regulator (controller). Variable values, trends and other dynamic
images on the faceplate and other windows of ExperTune are updated at the same interval.

The program checks the controller/regulator operation period and data collection interval for compliance. If the
requirements are met, the Sample interval checks OK message appears in the Options Table window at the bottom.

If the interval "does not match™, the program offers its value in the message:

Suggested sample time (sec) = X.X — recommended interval in seconds for PID controller and data acquisition for
ExperTune.

The program offers an interval time with a margin - about 10 times less than the process lag time, that is, near the
lower, "fastest" limit of the range. If we multiply this time by 2, we get a value close to the "slow" limit of the range.

Process Dead Time - process delay time

Process Dead Time (Dead Time, Net Delay) The "Process Dead time" is the time it takes for the PV manipulated
variable to begin to change after a change in valve position. The controller cannot force the PV to react before the process
delay time has elapsed.

Equivalent Dead Time - equivalent process delay

From the side of the controller, it may seem that the delay time of the process is greater than its real value. That is,
the controller cannot be tuned hard enough (but not unstable) for PV to begin to noticeably respond before the net delay
of the process ends. More precisely, the loop response time constant is determined by some “equivalent” process lag,
which is the sum of the net delay plus the additional “pull” introduced by process components that are more than 180
degrees out of phase.

The delay phase will increase in proportion to the frequency. Any process with a phase lag of more than 180
degrees has an "equivalent" lag.

Relative Response Time (RRT) - Relative loop response time

The RRT parameter is a relative indicator of the speed of the control loop. The shorter the RRT time, the faster the
loop and vice versa, a slow loop has a large RRT value.

RRT depends on the speed of the loop's response to a change in load or reference, and can be changed by changing
the Loop's Safety Factor or Setpoint Response (Lambda) time.

ExperTune determines RRT in the following way (see figure):

1) The frequency response of the closed loop response to the load step is calculated. 2) Find the frequency at
which the amplitude coefficient reaches a maximum

3) This frequency is converted into a period of time.

An example of determining the value of the RRT circuit

The amplitude-frequency characteristic has a maximum (peak) at a frequency of 0.0677 Hz. Since 1/0.068 = 15s,
the RRT of the circuit in this example is 15s.
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Often when using "aggressive", fast settings (Load-Fastest or Load-Fast), the response of PV to load disturbances
has the form of damped oscillations relative to the SP reference (see trends in the second figure). The period of these
oscillations is, roughly speaking, the same as RRT

The figures show that on the frequency response graph, as well as on the trend, the RRT time is 15 seconds.
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In this circuit, the fastest version of the PI settings "For Load" (Load-Fastest) with a stability factor SF = 1 was
used. (The process has a lag time of lag time = 6 sec and a net delay of dead time = 2). With these settings, the trend of
the PV response to a step load jump has the form of damped oscillations. The time between oscillation peaks is
approximately 15 seconds, which corresponds to the RRT value.

RECOMMENDATIONS

Interacting loops To eliminate unnecessary interaction of loops, set the values of the degree of stability SF (at the
settings "For load™) or the reaction time constant SP Response / Lambda time (at the settings "For task processing") so
that their RRT differs by 3 times. Let, for example, there are 3 circuits affecting each other, and the fastest of them has a
time RRT = 1 sec. Then reconfigure the other two circuits so that they have an RRT equal to at least 3 and 9 sec.

Cascade control In a cascade control scheme, the primary (outer) loop must have an RRT of 3 times greater, i.e. the
loop must be 3 times slower than the secondary (inner) loop. First you need to set up a "fast" secondary circuit, then set
up the primary circuit (master). If its RRT is less than 3 times the RRT of the secondary circuit, readjust the primary
circuit.
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How to ensure a good response of the circuit to both a load disturbance and a change in the SP
reference at the same time?

To do this, you need to set the reference filter (setpoint) SP in the circuit, calculated by the ExperTune program.
After that, SP will not be able to change abruptly.

For many PID loops, the “For Load” type setting, which provides better compensation for process (load)
disturbances, leads to an overshoot phenomenon when the controller is processing a change in the SP reference. The filter
smoothes the SP signal at the input of the regulator to reduce overshoot.

First tune the loop for optimal load compensation (Load Tuning), and then use ExperTune to set the SP filter to
eliminate overshoot when the reference changes. For more information about the SP filter, see the corresponding section
of the Guide below.

PV filter in control loop

The “Filter” option allows you to evaluate the need for a PV filter in the loop, its type and characteristics for a
particular process.

ExperTune will calculate the optimal PV filter for each PID setting of your controller and will allow you to see and
analyze on the model the effect of this filter on the operation of the circuit when the reference or load changes and the
effect on the noise level. It is also useful for analyzing valve wear.

If the controlled variable PV has a significant level of noise, then you can learn from the model how to suppress,
“smooth out” this noise using one of the filter types provided in ExperTune. However, don't try to use a filter to improve
the quality of the data, as this will cause the PID settings to be incorrectly calculated.

The filter time constant F should be chosen large enough to suppress the noise as effectively as possible without
compromising the performance/quality of the loop control. Too high an F value can disrupt the loop and reduce
performance as the control tries to "adjust” the filter. As a rule, the lowest level of filtering allowed by the user is the best
option for the circuit.

Since the settings calculated by ExperTune are determined by the raw data presented in the Time Data for...
window, the user can always check how the PV filter will affect the controller settings.

To set the PV filter in the contour model, select from the Trend Window menu: Edit-Filter... (Editing-Filter...)
ATTENTION: Filtering changes the source data of your process. When using a filter, all subsequent calculations of
the controller settings will be based on the data of the filtered PV variable.

The last filter operation can be undone using the Edit-Undo menu.

After selecting the Edit-Filter option, the PV Filter panel appears at the bottom of the Trend Window, where you
need to enter the time constant F you want to check and the filter type.

Filter Time constant (Filter time constant F): Time in seconds that determines the properties of the controlled
variable (PV) filter, its step response

Filter type: Choose from the list provided.

Test: To test the effect of the selected filter on the circuit, click the Test button. After that, the PV trend in the
Trend Window will be recalculated and presented with the filter already taken into account. You can continue to enter
other F values and click Test to see the result of the filtering.

Analysis of the influence of the PV filter on the operation of the circuit.

IMPORTANT: The raw process data used by XTune for loop analysis and setting calculations must be collected
without a PV filter. The filter can be removed automatically using the special function Un-filter PV (Remove filter).

In the faceplate window or in the archive files window (Off-line), after the “calculate settings” (Tune) command,
the “Find PV Filter” function becomes available. Select this feature by checking the appropriate box so that ExperTune
finds the largest but valid filter for the selected tuning option. The filter should, on the one hand, suppress interference
(noise) as much as possible, but at the same time should not significantly reduce the control efficiency (performance) of
the circuit.

Select a filter type from the list: 1st order filter, 2nd order filter, Butterworth, or averaging filter. You can select an
engineering unit for the filter, if desired. This can be done from the Edit Setup window of the loop: Advanced key - Loop
Setup... In fact, the PV filter time constant is the 4th PID tuning parameter (F), which is presented on the loop XT
faceplate along with three others. controller settings: P, I, D. We can talk about PIDF settings of the control loop.

Try changing the current and new filter times and watch the math model instantly update process response trends
and loop stability plots based on filter type and size. Analyze the effect of a PV filter on control valve wear using the
noise analysis and simulation capabilities of the Control Loop Simulation window (see example below). View in the “PID
grid” settings window the entire range of PV filters for all settings options, differently oriented to load changes (Load
tuning) or setpoint changes (Setpoint tuning), etc.
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Choose a filter to help reduce PV noise.

Filter types
ExperTune allows you to use several types of filters.
1st order filter This is the most common type of filter. It is described by the following equation:

PVf =PV + LagTime * (PVfl - PV) / (LagTime + Samplelnterval) where

PV = Adjustment variable LagTime = Filter time constant found by ExperTune Samplelnterval = Interval (period)
of reading PV values and filter calculation (PVf) PVf = PV after filter PVfl = Last value of PVf The time units of the
LagTime and Samplelnterval parameters must be the same.

2nd order filter This filter uses a cascade of two 1st order filters, each with a time constant of 0.5 of the F time
setting.

2nd Order Butterworth Filter This is a very efficient 2nd order filter. It is well suited for noise suppression as it
produces the least phase shift with the best noise reduction of any other filter.

Averaging filter This filter operates on the principle of "moving average" - with the frequency of filter calculation,
the average value of PV is calculated for the previous period of time, equal to the filter averaging time F. The influence of
this parameter on the filtration efficiency is approximately 2 times less than that of the filter time constant 1- order.
Therefore, in order to obtain an averaging filter equivalent to a 1st order filter, you need to set the averaging time to twice
the time constant of the 1st order filter. If you need to remove a certain frequency from the noise

(harmonic), set the averaging time to the period of that harmonic and this should completely suppress it. In general,
this type of filter is less effective than Butterworth at high frequencies.

The best filter is the 2nd order Butterworth, which is the most effective at suppressing high frequency noise,
although it is not as good at low frequencies. It is followed by another good filter - the first order.

A properly sized filter reduces maintenance costs and increases the life of the control valve. If the filter is too
"large"” (large F) and significantly affects the low frequencies, this can worsen the regulation.
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Frequency Responses of Filters

[EEExperTune Inc. - Coontroller Frequency Hesponse
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The figure shows the amplitude-frequency and phase-frequency characteristics of the filters. The filter times are
chosen so that all filters have the same effective time constant, i.e. the same phase shift at low frequency. The
characteristics of different filters are shown in different colors:

red - 1st order (1p), time constant F = 10; yellow - 2nd order, two lag links with F = 5;

green - Butterworth (Btw), F = 10; blue - averaging with a window length of 20.

An ideal filter suppresses interference (noise) and does not cause phase shift. The more noise is reduced, the better.
The crest factor on the frequency response shows how noise is reduced at a given frequency. The smaller this ratio, the
greater the noise reduction.
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Transient response of filters

lawExperTune Inc. :  CO Pulse Time Response
File #-AxsReange Y-Axis Range

Response of filters to impulse

-Eule H-fods Fange

Along with noise reduction, the filter causes a phase shift, which is bad because it distorts the signal. The smaller

the phase shift, the better. The effect of such a shift after setting the filter can be seen in the Trend Window.

Filter Time Constant Requirements F (PID-F)

The filter time constant should be:

* Less pure process dead time
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Setting the DDE address(es) for reading and writing the filter value in the governor/controller.
The Filter Addresses Setup window for setting the address(es) for the filter time constant F in the controller is
called from the edit window: Edit Setup - Advanced - Filter Address. The address can be one or two - separately for
reading and writing.
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Unique write location - A separate write address. If this checkbox is not checked, then one common DDE address
for reading and writing will be used for the filter in the controller, if the checkbox is checked, then two DDE addresses.
According to the DDE protocol, the full address must have the structure Application|Topic|ltem

Note. The APACS+/QUADLOG controllers have a FILTER function block that acts as a 1st order filter and can
be used to set the PV filter. The block has a parameter TLAG - filter time constant in minutes.

The DDE server can be either an APACS 1/O server (Application|Topic = APACS|DATASERVICES) or a Vision
Framework application (Application|Topic = VIEW|TAGNAME).

The option of setting the digital filter time constant is also provided in the configuration parameters of the analog
input channels of the 1/0 modules SAI, SAM of the APACS+ system.
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SP job filter

The SP filter allows you to get a good transient response - loop response

both when the load is disturbed (PV) and when the SP reference is changed. ExperTune finds the optimal filter for the SP and,
using an extensive database of different types of controllers, performs modeling and simulation of the loop operation, which allows
the user to quickly obtain and compare the transient response and results of the SP filter.

The “SP Filter” (Setpoint Filter) option is available in the Control Loop Simulation window, which is called after pressing the
Analysis key.

Simulation of the SP filter and transient response - loop response.

EEuuerTunE Control Loop Simulation - Set Paint
Cptions  Time Rangs Help

[= alwlr| Flir| 2= =)

F_ - show the reaction of the contour model when the task is changed (Ortion|Setpoint Plot)
ﬁl - show the reaction of the circuit model when the load is disturbed (Ortion|Load Upset)

El - show on the model the reaction of the circuit to a change in the task with the SP filter and new PID settings.
This is equivalent to choosing: Ortion|Setpoint Plot, then Option|Setpoint Filter|Use Lead/Lag Setpoint filter (Options|SP
Filter|Use Lead/Lag filter)

|F£| - Set the ratio of Lead and Lag time constants (Option|Setpoint Filter|Adjust Lead/Lag Setpoint Filter =
Options|SP Filter| Adjust Lead/Lag Filter ). Lag time is automatically set by the program to be approximately equal to the
integration time in seconds

E ExperTune Control Loop Simulation - Set Poink EE ExperTune Control Loop Simulation - Load Upset

Options  Time Range  Help Options  Time Range  Help
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After selecting the Use Setpoint Filter option, the program shows in the Contour Modeling window additional
trends for the contour with the SP filter: black is the SP job,
magenta color - PV and CO.

SP filter programming.

Below are the equations for programming the lead/lag block that implements the SP filter function in the
controller/regulator.

Calculation Lag: y = SPuserSet + LagTime * ( y1 - SPuserSet ) / ( LagTime + Samplelnterval ) Calculation Lead :

SPcontroller =y + LeadTime / Samplelnterval * (y - y1 ) y1 =y /* save for next calculation cycle Initialize set to y1
equal to the current value of the SP controller.
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Variables:

SpuserSet = task entered by the user LagTime,LeadTime - time constants Samplelnterval = lead lag calculation
period of the filter y1= last value of y y= intermediate value (lag output) Spcontroller = value sent to the controller SP
input

To implement the SP filter, use the lead/lag function block of your system (for example, in the
APACS+/QUADLOG system) or another way to program these equations.

Loop Summary Table - Loop Summary Table

The summary table (log) should help the user choose the best contour setting option. The log is called from the
faceplate or the Trend Window by pressing the key or from the Options menu.

While working with the ExperTune program for testing and analysis, a certain effect is exerted on the contour,
various disturbances are introduced and arise. To analyze each disturbance, the Zoom In option is applied to the collected
data, which allows you to select and process the desired part of the trend. As a result, depending on the quality of the data,
the linearity or non-linearity of the contour, and also, possibly, on the direction (sign) of the controller action, the program
gives slightly different settings. Use the Logbook to log and view the different settings for your circuit.

Recommendation

The tuning log automatically calculates the average of all tuning parameters recorded in the log, and also
determines the most conservative loop setting. Some circuits are non-linear and behave differently at different ends of the
range. Others are asymmetric, and their response depends on the direction of the impact or perturbation. For example, in
temperature control loops, heating usually occurs faster than cooling. In such cases, you should analyze the operation of
the circuit at different ends of the range and / or in both directions and choose the most conservative of the settings
obtained.
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Pivot Table Columns.

Archive : number of the contour archive file from which the settings values are calculated
Zoom start, Zoom end : Part of archive file data (trend section) used to get settings.

P, I, D, F: Recommended values for tuning factors (settings).

Fit : The quality of the original data, as determined by the frequency response

Gain: Process gain (transfer) obtained by ExperTune
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DT : Dead time (dead, pure delay) of the process Dead time found by the program.

Lagl: Lag - in analog technology, a link for smooth “pulling”, lagging behind the analog signal. Another name is a
capacitive link. Lag time - link lag time constant. If ExperTune has defined a process model with one or two lag links,
then this column of the table indicates the Lag time of one or the first of the two lag links. See the figure below for the
dynamic characteristics of the lag and lead links.

Lag? or Lead: Lead - in analog technology, a link with a "lead" of the input analog signal (see figure). If
ExperTune has defined a process model with two lag links or with a lead link of a “leading” process, then the time
constant Lag time of the second lag link or a similar Lead time parameter is given here. The last (Lead) can only be in the
case of a process with a reverse (inverse) reaction.

Intg : If the ExperTune model has defined the process as "integrating”, then this column contains the word "yes"
(yes)

Lag time is the time constant of the capacitive link or first order process. The time after the net Dead time that PV
reaches 63.3% of its new steady state after a valve step change. There are very few real processes that have only a lag of
the lag type, almost all of them contain a "pure delay" Dead time.

Dynamic characteristics of links of tightening Lag and advancing Lead of analog signal
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Stability : The relative stability index of the contour. The most conservative, that is, the most stable setting option
is taken equal to 100. All other settings are evaluated relative to this option. Their index is less than 100, it shows how
much less conservative this setting is. For example, an index of 50 indicates that the setting is 2 times more aggressive
than the most conservative setting. When a new setting is added to the log, this entire column may change.

RRT : Relative loop response time at given settings.

Notes : Comments about each setting. If the comment does not fit on the line, then by placing the cursor on this
field, you can see the full comment.

Time unit line: The second line of the table header shows the time units used in ExperTune models. If different
models have different units, then the models are converted and reduced to one, smaller unit. For example, if one model is
in minutes and the other is in seconds, then the former will be converted to seconds.
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Keys

Add - Add. A new line of PID and F parameter values is added to the log, which are currently recorded in the New
controller settings column on the faceplate.

Remove - Remove the selected row.

Copy to New - Copy the values of the PID and F parameters of the selected setting to the New column of the new
controller settings.

View Archive - view the archive file corresponding to the selected setting. The program opens the Data Trend
Window for this archive file. The same result can be obtained by double-clicking or right-clicking on the first three
columns of the PivotTable.

Report - Add a PivotTable to an MS Word document.

Change Notes - Change the comment for the selected setting. The same can be done after double-clicking on the
comment text.

In general, double-clicking or right-clicking in the PivotTable window allows you to perform the following
functions:

* Copy the values of parameters P,I,D and F to the column New

* View archive file data

* Edit comments

» Add Table to MS Word Report

* Copy the window to the clipboard as a .bmp image file, from where it can be pasted into any document

* Double-clicking in the area of the first three columns automatically opens the window for viewing the data of the
selected archive file.

6. ANALYSIS OF THE DATA OF THE STABLE OPERATION OF THE LOOP

This type of analysis is used to investigate the normal operation of a loop in a stable state with the SP setpoint
unchanged.

Note. For a number of analysis tasks, such as statistical and frequency analysis of the contour, histogram, and
others, information is needed on the stable operation of the contour without jumps and transients. Data collection for this
case is different from other tests. The necessary data can be obtained here in the following way:

» When the loop is stable, collect data again specifically for analysis using a semi-automated procedure with
manual data acquisition on and off.

* Using the Zoom In option, in the Trends Window, edit the information of the archive file of one of the previously
performed tests of this circuit, selecting for analysis the desired section of data on the stable operation of the circuit.

Statistical analysis and histogram
Collect data during normal stable closed loop operation (no spikes or transients) before and after changing settings.

Using the "Statistical Analysis" option in the Trend Window, call up the statistics window and see how the quality
of the regulation improves with the new loop settings. Compare the statistics before and after.

Comment:

1. All statistical calculations are based on the data presented in the Trend Window, and these data can be edited,
including using the Zoom in function. Therefore, care must be taken to ensure that the data are always comparable.

2. The volume of collected data should be sufficient for the reliability of the results of the analysis.
The results of the statistical analysis of the contour are presented in tabular form in a special window "Statistical
Analysis", which is called from the Trend Window. The table shows PV statistics: mean value (Mean), standard deviation

(Standard deviation), indicators of variability of the variable PV (variability), etc., as well as valve statistics (CO
Statistics): stroke (travel distance) and valve reverse indicators
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Normalized option: Selecting this option normalizes all statistical information, converting it according to a
percentage scale of 0 - 100%. This helps to compare the statistics of different circuits, because all the main parameters:
PVmin, PVmax, range, mean, standard deviation, variance, IAE and valve travel will be presented on the same scale.

Statistical contour parameters

Sample (raw): Data collection interval for the selected archive file.

Num of points: Number of collected PV points

Range: PV data value range

Mean: Arithmetic mean of collected data

Variance: Variance is a value that characterizes the spread of data values.

Sample variance= sum(Mean-x(i))"2/(npts-1

Standard deviation: The standard deviation of the random variable PV is the standard deviation from the mean,
equal to the square root of the variance.

Variability: The variability of a random variable PV is the relative value of the variance. It is expressed as a
percentage of the average and allows you to compare the level of variability of different processes.

Variability= 2*(Standard Deviation)*100/Mean

Variability Index: The Variability Index is a statistical measure of the efficiency (performance) of a controller
compared to the virtual "best" efficiency achieved with an "ideal" loop control with the smallest possible dispersion. This
index is calculated by the program and takes values in the range from 0% to 100%, where 0% corresponds to the "ideal"
with the minimum variance, and 100% is the worst case.

We can say that "variability" is a measure of the "non-ideal" regulation.

IAE (Integrated Absolute Error): The real cumulative (total) absolute controller error is the integral of the PV-SP
difference for the data presented in the Trends window. ExperTune calculates IAE only if the window contains data on
the SP task of this circuit. For example, an additional contour may not have an SP trend. The IAE parameter is a measure
of the efficiency of a loop. IAE is equal to the area of the part of the Trend window between the SP setpoint curves and
the PV variable. The lower the IAE, the better, as it means the loop is working closer to the target. The IAE parameter is
useful in that it is easier to associate with financial and economic indicators in various industrial enterprises than any
other performance indicator.

In many cases, control loops must work as close as possible to the requirements of the technical regulation
(specification), with a minimum of deviations. Let, for example, an expensive MTBE additive be added to gasoline so
that its concentration is 2%. On the one hand, adding more than 2% MTBE is a financial waste, but at the same time, it is
necessary to add enough to provide the required 2%. A typical approach is to set the SP target slightly higher than 2%
MTBE. Then, the better the loop is tuned and the lower the IAE, the closer to 2% the loop can be set and the lower the
MTBE flow will be.

To the right of the IAE parameter is a combo box where you can select the time period to extrapolate the IAE by
hour, day, week, month, or year based on the data in the Trend Window.

An example of a statistical analysis of the operation of the circuit under normal conditions with a constant value of
the reference SP
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The PV trend shows the presence of cycles and load disturbances
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CO Statistics - Regulator and valve output statistics.

Travel: Valve travel, valve travel,

Reversals: Number of valve reversals

The CO signal first passes through the pneumatic converter, then the control mechanism moves the valve stem.
ExperTune determines the amount of stem movement from the change in CO and calculates the stroke length and valve
reversals. Valve travel is an estimate of the total distance traveled by the valve stem as a result of changes (“movements”)
in the CO signal plotted in the Trend Window. Reverses are the number of changes in the direction of movement of the
rod, also occurring due to changes in CO over time.

Use valve travel and reversal performance and loop modeling capabilities to analyze the loop and reduce valve
wear. Data collection for these tests should be performed in the automatic mode of the regulator during normal, stable
operation of the loop.

To the right of the “CO Statistics” table, the values of the stroke length and the number of reverses for the selected
time period are given: hour, day, week, month, year. For example, if the valve stroke is 100% per day, this means that the
valve travels a distance equal to its full range in 1 day. At the same time, it can, for example, move 1 time from one
extreme position of 0% to the opposite 100%, or move 10 times back and forth between positions 50% and 60%.

Bar chart

The histogram is also built based on the results of statistical analysis and is called from the Trends window. You
may need to use the Zoom In option before doing this to select the trend section with the desired "stable" data.

In the general case, to build a Histogram, it is necessary to collect data on the normal operation of the circuit in a
stable state. In the case of a closed loop (automatic regulator mode), the SP reference must be fixed, while in manual
mode, the output of the CO regulator must be unchanged. In this case, to compare two histograms of the same contour,
for example, before and after changing the settings or in Manual and Auto modes, you must always use data for equal
periods of time

The histogram allows you to see and evaluate the statistical spread of your contour data. If the noise is "white",
then the histogram will have a symmetrical bell shape. Place the cursor on or above one of the columns that make up the
histogram, and a small box will display the % of data corresponding to that column.

PV histogram

Collect data in the automatic mode of the controller and call up the Histogram.

The shape of the approximating curve, which envelops the histogram along the tops of the columns, makes it
possible to judge the quality of regulation and possible contour problems:
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» A tall and narrow bell curve indicates good
contour tuning and slight deviation.

« a low and flat bell indicates a poorly tuned
contour and a large deviation.

« if the histogram looks like an inverted bell, that is, with a
hollow in the middle, this indicates a possible sticking of
the valve.

The histogram on the left is derived from data collected
under normal, stable loop operating conditions. The two
humps on the left and right show that PV values are
usually found

on some one side of the SP job, so a stick test must be
performed.

Compare the histogram curves before and after adjustment. If the setting has improved regulation, then the
histogram bell should be higher.

A similar property is true for the Automatic and Manual modes of the circuit. If the setting has improved
regulation, then the histogram curve in Auto mode should be higher.

Loops with cyclic oscillations, and especially those with valve sticking, often give two "humps"” in the histogram
on the left and right at the ends of the curve.

Controller error bar graph (E = PV-SP)

Collect data in automatic loop operation. If the data in the histogram is grouped on one side of zero, this indicates
the presence of some kind of non-linearity in the contour.

Plot of PV vs. CO (XY Plot)

The window with the graph of the dependence of the controlled variable PV (Y axis) on the output of the CO
controller (X axis) is called up on the screen from the Data Trends Window by the corresponding key or through the
Options menu: Options - XY Plot. The PV and CO scales here are the same as in the Trend Window. When you change
the scale in the Trend Window, the XY scale of the chart changes similarly. Each data point (pair of values) in the Trend
window corresponds to one XY point of the graph. These points can be connected with lines (selection in the Options
menu).

The XY plot can be useful for identifying oscillatory contours. In the case of such a contour, there will be very few
points in the center of the XY graph. The plot image option (points, lines, thick line) is selected in the Options menu. (see
figure).
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Autocorrelation

A decrease in the area under the autocorrelation curve indicates that changing the settings and other actions you
have improved the regulation, making it less deterministic, more random.

In addition, autocorrelation helps to detect cyclical fluctuations in the contour - this can be seen better on a
correlation plot than on a trend. For example, a 10 second cycle in a flow control loop is likely due to a failed regulator
setting. If the cycle has a frequency of 2 or 3 Hz, then the possible cause is pump pulsation.

Confidence limits (2/sqrt(Npts)) are shown in the graph as blue lines. Here Npts is the number of points, sqrt is the
square root.

Cross-correlation of two PV signals

Correlation analysis helps to see and evaluate the degree of influence of one contour on another.

To analyze the cross-correlation of two PVs, in the Setup window, select (check) one of the PV variables as the
output of the CO controller.

Use cross-correlation to reveal the presence of an interaction, a relationship between two contours. If there is no
dependence, then the values of the cross-correlation plot will be close to zero.
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FREQUENCY ANALYSIS

Loop testing for spectral analysis is different from tests designed to determine controller settings. The collected
data should not contain any special jumps in the SP reference or CO output, such as tests for loop tuning. Data acquisition
must be performed under stable loop conditions.

Signal Power Spectral Density

Diagrams (graphs) of the signal power spectral density are called from the Trends Window by pressing the button
or through the options menu: Options > Power. Next, you can choose a spectrum option:

» Deviation - controller error spectrum E = PV-SP (not always available)

* PV — PV spectrum.

* CO - spectrum of CO.

Spectral charts can be used to evaluate the improvement in loop performance as a result of changing the controller
settings. The diagram shows the distribution of relative signal strength over various frequencies (harmonics) over a range
of periods from twice the sample interval to twice the total test time.

. They can be used to test the efficiency of a regulator without having to test the loop by changing SP or CO. The
power spectrum of open loop data defines the break point (transition) between frequencies that carry load disturbances
and frequencies that contain only minor noise. The goal here is to react only to perturbations.

One of the effective applications of spectral diagrams is the identification of any cyclic disturbances and their
frequency components. Collect PV variable data in open loop (regulator in manual mode). The presence of peaks in the
spectral density plot below the transition frequency should be considered suspicious. Is this peak caused by a cyclic
perturbation in the circuit? Or is the peak caused by mechanical vibration? Check the manifestations of this frequency in
the technological process and find a causal relationship with a similar frequency somewhere higher in the production flow
chart.

Another use of Spectral Plots is to evaluate the quality of a regulator's tuning. Collect PV data in closed loop
(regulator auto mode) before and after tuning. The smaller the amplitude of the values in the diagram, the better the
setting.

Cumulative Power Spectrum option.

This type of frequency spectrum shows as a percentage the total power of all harmonics below a given current
frequency. The usual frequency spectrum does not always allow you to quickly find the contribution of a particular
harmonic to the total noise power. A harmonic can produce 10% or 90% of the noise power - the power spectrum itself
does not show this. The cumulative spectrum shows that a certain percentage of cyclical fluctuations, perturbations is
below a given frequency.

Spectral frequency analysis is performed by applying the Fourier transform to the trend - the plot of the PV/(t) or
CO(t) function that was obtained as a result of the contour data collection.

Clustered Peaks
Neighboring peaks grouped around a large peak or several such peaks form a "cluster" (group). ExperTune
calculates the power of a cluster by summing the power of the peaks in this group.

The parameters of four such clusters are given below the spectral diagram. For each cluster, the following is
indicated: the coordinate along the X axis - the frequency in Hz (or the period in sec), as well as the share of the occupied
signal power in%.

Cluster power = the sum of the powers of the peaks in the group. Cluster coordinate = average of the coordinates of
all peaks in the cluster, weighted by the power of each peak.

Therefore, it is likely that the cluster coordinate will not coincide with the location of any one peak. If there is a
large peak in the cluster, then the X-coordinate (frequency) of the cluster will be close to the frequency of this peak. The
use of clusters makes it possible to more accurately determine the peaks and their power.

Peaks in Zoom Area Only option.

Selecting this option causes XTune to use only those peak clusters that are in the selected (Zoom In) area of the
Chart. By default, the largest peak clusters are searched across the entire spectrum.
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7. SIMULATION AND CONTOUR ANALYSIS

Simulation of the technological process and circuit, analysis of optimization results

Model and Analysis Windows

After calling the Tune controller tuning function (for an archive file) or at the end of the AutoTune procedure, the
Controller Tuning Panel opens on the faceplate, the Analysis button appears to the left of it, and the New column shows
the recommended new PIDF controller settings (provided that the quality of the original data is good enough to calculate
the settings).

Clicking the Analysis key brings up four windows - four powerful contour analysis tools (see the figure below):

* Process Model window

* Process Frequency Response window

» Control Loop Simulation window

* Robustness Plot Contour Stability Chart Window

When you change the process model selection, all four analysis windows instantly update to match the new model.
If you change any of the PID controller settings, then the loop modeling window and the stability graph (analysis)
window are updated, which depend on these parameters.

One of the most useful and powerful analysis tools is the Control Loop Simulation window, which shows the trend
of the loop response to new settings before they are loaded into the controller. More importantly, not only the response to
a change in the SP task is modeled and shown, but also the response to process upset load disturbances. Usually, the user
needs to check the response of the circuit, eliminate or reduce just random disturbances, load surges that occur on the
control object. In most cases, this is more important for product quality and reducing production losses than an optimal
response to a job change.

The transient characteristics (response) of the circuit when changing the reference and load can be very different.
On a running object, it is rather difficult to check the operation of the circuit when the load is disturbed, but this can be
easily done using ExperTune.

However, it must be borne in mind that any simulation is based on the use of a mathematical model of the process
and directly depends on the quality of this model. Therefore, the choice of a process model is very important for the
results of modeling the operation of the circuit and should be the first step in the analysis procedure. ExperTune provides
two Laplacian models - first and second order. The process model is based on the frequency response of the process,
which in turn is built from the collected test data presented in the Trend Window. Thus, the quality of the models, the
results of modeling and analysis of the contour, the graphs of stability - everything depends on the quality, reliability and
consistency of the primary data collected.

The Frequency response window simultaneously shows the amplitude and phase characteristics of the real process
and its model selected by the user. The degree of coincidence of the characteristics shows how the selected model
corresponds to the real data. It is necessary to choose the model that best matches the actual frequency response of the
process, with the most important frequency range where the phase shift is between 90 and 180 degrees. When the model
changes, all other analysis windows are instantly updated.

After selecting a process model, the loop simulation window shows the step response of the loop model at the
current and new PID controller settings. In practice, you always have to find a compromise between speed (hard tuning)
and the stability of the circuit to changes in process dynamics. The Contour Stability Analysis Window (Stability Graph)
helps here. If there are two PID settings with approximately the same degree of loop stability, then you can safely use the
faster setting.
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Process Model window

The window shows the process model found by ExperTune from the frequency response of the process and
presented in terms and notation of the Laplace transform and operational calculus as an algebraic expression , where s is a
complex variable.

The table below the model formula shows the values of the dynamic parameters of the process:

* Gain - gain factor

* Dead time - delay

* Time constants - time constants

If the process is an integrator, then the 1st order time constant is referred to as “integrator” (see figure). If the 2nd
order model has imaginary roots, this is denoted by the word "imaginary".
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Model type selection:

To determine the type of model, it is necessary to make a choice of the proposed options in two lists.

1. About the use of the stable state Gain coefficient.

The following choices are possible:

« Allow gain to float - Allow the Gain factor to change. The program ignores the steady state information of the
process and builds a model that matches the frequency response at higher frequencies, which are more important for
optimal and stable closed loop operation.

* Force steady state gain - Adopt the stable state gain Gain. In this case, ExperTune takes Gain equal to the value of
the frequency response at the lowest frequency. In this case, the model is built according to the remaining “good"
frequencies.

The frequency response value at the lowest (zero) frequency is not displayed at all, so it may be that the model
response does not match the process response at the lowest frequency.

2. Model order

ExperTune automatically selects whether to use a 1st or 2nd order model depending on the degree to which the
frequency responses of the model and process match. If the models differ insignificantly according to this criterion, then
the program uses only the first-order model. However, the user can force the order of the model. If, however, the data
quality is not good enough, the message "Data not good enough to support this model structure" is displayed instead of
the model formula.

The following choices are possible:

« "Automatically Choose Best" - Choose the best option automatically. ExperTune chooses the best model by itself,
as described in the previous paragraph.

* "Force First Order With Dead Time" — Use a first order model with found Dead time values of gain, and Time
constant

* "Force Second Order With Dead Time" - Use a second order model (there is a variable s squared” in the
formula) with the found values of Dead time and Gain.

* "Force Integrator With Dead Time" - Use the integrator model with found Dead time, Gain factor and integration
time.

If in the Advanced window (called through the Edit Setup loop editing window: Advanced - Loop Setup... -
Advanced button) the Inverse response process option was checked, then the Lead time and Integrator additional
parameters are shown in the process model window (see the example above and a description of this type of process in
the Contour Problems section), and the model order is automatically chosen by ExperTune - it is forced to "Automatically
Choose Best".

Option Start Simulator With This Model - Starts the software loop simulator with the current model, PID algorithm
and current PID settings, provided that the computer has the software simulator ExperTune Loop Simulator installed.

Process Frequency Response window

If you apply a sinusoid to the input of a linear system (process), then the output of the PV process will also be a
sinusoid, but, in the general case, with a different amplitude and, possibly, with a time delay relative to the input signal.
The ratio of the amplitude of the signal at the output to the amplitude at the input is called the "dynamic gain" of the
process or “cream factor”, and the time lag of the signal is called "phase shift" or simply "phase". The crest factor AK is
measured in decibels, where dB = 20log (AK).

Different harmonics give different amplitude coefficients and phases, and the entire spectrum of harmonics allows
you to build the frequency characteristics of the process: amplitude frequency response and phase phase response.

The window shows the characteristics of the real process and its model (selected type), which makes it easy to
compare them.

Frequency responses are plotted from actual loop test data presented in the Trend Window, so the quality of the
model, like the PID settings, is highly dependent on the quality of the input data. In the general case, good, high-quality
data correspond to smooth, smoothly decreasing from left to right with increasing frequency, the curves of the
characteristics of the frequency response and phase response.

The better the collected raw data, the smoother the frequency response looks and the more accurate the model, the
better the result will be the PID settings calculated by the program.
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The actual process characteristic usually contains noise or peaks at higher frequencies on the right.

The characteristics presented in the window help determine the best process model. To do this, in the general case,
it is necessary that the model curve correspond as much as possible, coincide more closely with the real characteristic of
the process at frequencies where the phase shift lies in the range between approximately 90 and 180 degrees. The figure
shows how to find these frequencies.

Options:

* Radians/sec or Cycles/sec — frequency unit: radians/sec or hertz. The default unit is radians/sec.

» Show High frequencies — show high frequencies. The program shows the frequency response and phase response
for frequencies where the phase is less than -270 degrees. Usually these high frequencies are not shown on the graph.

If f is the frequency in hertz, w is the angular frequency in rad/sec, then w = 2xf.

The angular frequency for the time constant T(sec) is defined as 1/T radians/sec.

Control Loop Simulation window.

In this window, on the selected model, the operation of the circuit is shown in a stable state and during transient
processes - how the selected process model and the controller react to external influences: a change in the reference, a
load jump, noise at the input, etc. with current and new PID settings and filters.

If the user changes the process model or any parameter of the PID settings, the loop response trends are instantly
recalculated and new trend graphs are shown in the window. This allows the user to try, compare and select different
settings on the model.

The top half of the window shows the PV trend and the SP reference, the bottom half shows the controller output
(see figure). At the same time, different trend colors are used for the current and new settings:

» Current settings: PV, CO - blue, SP - black

» New settings: PV, CO - red, SP - black

When using SP reference filter: PV, CO (with SP filter) magenta, SP with filter black

Keys in the contour modeling window.

Note. All main ExperTune windows have Options menus that duplicate the function keys of this window.
Therefore, the English names of the keys (options) are also given here.

&{ Load Plot - show the response to a load jump/disturbance. If the setting option "For load" is selected in the
Controller tuning window, this reaction is shown first.
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EI Response to measurement noise — response to interference (noise) of the PV signal. Useful for evaluating

the positive impact of a PV filter and analyzing valve wear.

E_E_EHperTune Control Loop Simulation - Measurement Moise Response
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ﬁl Actual PV compared to simulated — Comparison of the real PV trend with the model. Shows the reaction of
the process model to a real changing signal at the output of the regulator, the graph of which is presented in the Trend
Window. ExperTune plots the PV trend based on the dynamic process parameters specified in the Process Model
Window. The actual output of the CO controller "acts™ on the process model. The "Output” of the model is displayed at
the top of the window along with the actual PV trend from the Trend Window.

E_EExperTune Process Simulation - Actual P¥ Compared to Simulated
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El Setpoint Filter Option — Option to apply in the SP task filter model. In addition to the key, you can select
from the options menu: Option|Setpoint Filter (SP Filter)|Use Lead/Lag Setpoint filter (Use Lead/Lag filter). When this
option is selected, ExperTune applies the SP job filter to the loop model with the new PID settings. Access to the option
can be disabled if ExperTune considers that the SP filter is not needed for this knob with these settings.

o
Ophions  Time Range  Help
e L e Wl = =
5P filter IN USE: lead=0 lag=5.1 ratio=0
43.025
AR
P
43.025
1 1 1
3. 140 160 180
45064
co N
37907
1 1 1 1 1 1 1 1 1
37.368 20 a0 60 80 100 120 140 160 180
Current New 5P New Filtered Time (seconds)

With the help of the SP filter, it is possible to ensure a good response (transient response) of the circuit at the same
time to changes in the reference and to load jumps. For many circuits, the controller setting, which is optimal for
compensating load disturbances, leads to unacceptable overshoot when the reference changes. To attenuate, dampen
overshoot, the SP filter smooths out the change in the SP signal before it enters the input of the regulator.

Robustness Plot Contour Stability Analysis Window

Loop stability graphs are an effective analysis tool. They graphically show the degree of stability (or sensitivity) of
your circuit to changes in the dynamic parameters of the technological process - Gain gain and Dead Time, as well as the
trade-off between speed and stability. This window is convenient to use for a quick analysis of the stability / stability of
the contour.

When tuning, you always have to look for a compromise (balance) between the speed and stability of the circuit,

since a fast circuit with a short reaction time is sensitive to changes in the dynamics of the process and is subject to
fluctuations (oscillatory circuit), while a stable circuit, on the contrary, works more slowly.
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The cross indicates the point corresponding to the current process with the real values of the delay and gain, to
which the controller is set. Changes in the Process Gain and the controller proportional gain P have the same effect on
closed-loop stability. On the graph, you can see what happens to the loop stability when the process parameters
DeadTime and Gain are changed independently.

During a comparative analysis, this window shows two stability limits: blue for the current controller settings, and
red for new settings (see the figure below).

Usually, the stability margin that maintains the stability of the loop when the process parameter changes by 2 times
(or SF times, where SF is the Safety Factor stability factor) relative to the current process (cross) is considered sufficient,
“acceptable” for the loop.

The points obtained by multiplying or dividing by 2 the coordinates of the current process are represented on the
graph by the vertices of the blue trapezoid, which shows the zone of acceptable drift of the process dynamics. The
vertices are connected by lines, which on a logarithmic scale become straight line segments. In practice, to ensure the
stability of the system, it is necessary to maintain the contour settings so that the line of the stability boundary always
passes outside the blue trapezoid.

The loop stability graph is calculated based on the process model and controller settings, the accuracy of the graph
depends on the accuracy of the model. If you select a different model, the graph is updated.

If the contour is very stable or, conversely, very unstable, then the lines of the boundaries of stability may go
beyond the graph.

Stability graph presentation options In the Options menu, you can select two options for the stability graph
presentation during simulation - in absolute or relative units of the Gain and Dead time process parameters:

Actual Gain and Dead Time - absolute (real) values of the process parameters along the coordinate axes. This
option is the default.

Gain and Dead Time Ratio (relative values of Gain and DeadTime) — presentation of the graph in relative units of
the coordinate axes, where

Relative value of parameter Gain or DeadTime = (parameter value)/(current parameter value to which the knob
was set)

The cross on the graph, where both relative coefficients are equal to one, corresponds to the process parameters to
which the loop was tuned.

Estimation of the increase in the stability of the contour with new settings

At the top above the graph, in a special window, the value of the Robustness Increase parameter is shown - the
expected calculated increase in stability in percent with the new settings. If the stability, on the contrary, decreases, then
the Robustness Increase value will be negative, and if the circuit becomes unstable with the new settings, the N/A
designation is displayed instead of the number. This parameter can be used to quickly, numerically enter into ExperTune
a requirement for how much stability should improve when switching to new settings.

The calculation of Robustness Increase is based on comparing the values of another parameter - Closest Distance at
the new and current settings (see below).
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If you select the Gain and Dead Time Ratio option (representation of the Stability Graph in relative units), in the
window above the graph, in addition to the Robustness Increase stability increase parameter, you can see the Closest
Distance parameter (smallest distance, gap) for current (for current) and new (for new) settings.

Closest Distance - the minimum distance, that is, the smallest gap on the stability graph (in relative units) between
the cross of the current process and the line of the stability boundary. This parameter is a relative numerical measure of
the stability of the circuit, and rather conservative (careful, taken with a margin). If the boundary of stability passes
through the cross, this means that the contour is on the verge of instability.

When viewed, the red values of the parameter refer to the new settings, and the blue values to the current ones. If
the contour is unstable, then the Closest Distance value = N/A.

Thus, the parameters Robustness Increase and Closest Distance give a numerical estimate

stability, stability of the control loop.

How to introduce the desired degree of stability of the circuit into the system. With the mouse, the user can "drag"
the red line of the stability boundary to the left or right for new settings, thus setting the desired degree of contour
stability. In this case, the proportional gain controller is automatically adjusted so as to obtain a new preset stability.
Moving the stability border to the left reduces the stability margin, but gives a faster reaction (increases gain). Moving to
the right gives a more stable contour with a slower response. Since ExperTune also adjusts the integral | and differential
D components of the PID settings, such tuning by the Safety factor (margin) for many circuits gives the best balance
between stability and speed.

Processes with a low delay Dead time If the delay (dead time) of the Dead time process is close to the data
collection interval during testing, then ExperTune estimates the value of this delay very carefully, with a margin.
Therefore, if your workflow has a very low Dead time, its model will turn out to be less stable than the real process. The
stability boundary line for the model will move lower, and the transient characteristics of the model in the analysis
windows will also look less stable.
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Examples of the influence of the proportionality factor (gain) of the regulator on the stability and operation of the
circuit

1) Optimum balance between stability and reaction speed when compensating for load upsets (load upset)
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Generalized performance indicators of the new recommended circuit settings Performance Summary.

Z Performance Summary | x|

[Performance Inciease [65% Evaluation
|Robustness Increase  |646%

Valve ill\!'!l Index 321% Time Line
[Valve Reversal Index [1200%
[Valve indices based on || gad ~

I_Euuenl RRT (sec) 15
New RRT (sec) 44 Help

The Performance Summary window and additional windows called from this window by the “Evaluation”
(Graphical representation) and “Time Line” (Dynamic parameters of the circuit) buttons allow, using simulation and
generalized indicators presented in numerical and graphical form, to evaluate the effectiveness of the new recommended
controller settings compared to the current settings. To do this, the window presents generalized indicators that
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characterize the expected increase in productivity and improvement (more precisely, change) in other important
parameters of the circuit.

Regulator tuning is always a compromise between different requirements: performance versus loop stability, and
possibly performance versus valve life. The window shows the summary result of these compromises implemented in the
contour settings. To see all this in more detail and in graphical form, click the “Evaluation” button (Detailed Evaluation).

Performance Increase - Increase in productivity, production efficiency of the circuit.

This indicator tells how much better the PID controller will compensate for load surges at the new recommended
settings. Usually it is proportional to the possible savings in money. For details, see section 5 “Controller settings.
Calculation of PID settings and filters” — Controller settings panel (approximately page 42).

Loop performance is the effectiveness of the control loop in the process, affecting the quality and cost of
production. It is determined by the speed and quality of regulation in the circuit. Ultimately, this indicator is proportional
to the economic efficiency of the circuit.

Robustness Increase - Increase the stability (stability) of the circuit

An estimate of the increase in loop stability, the expected percentage increase in stability at the new settings. If the
stability decreases, then the Robustness Increase value will be negative, and if the circuit becomes unstable with the new
settings, the N/A designation is displayed instead of the number.

See Section 7 “Contour Modeling and Analysis” — Robustness Plot Contour Stability Analysis Window (roughly
pages 47-48) for details.

Relative Response Time RRT - Relative response time of the loop.

Relative indicator of speed, speed of response of the control loop to a disturbance. The smaller the RRT, the higher
the speed, and vice versa, the larger the RRT, the slower the circuit. This indicator is convenient to use for various tasks
of comparing contours, models and settings.

The value of RRT depends on the response speed of the loop: the user can change it by changing the Safety factor
or the Lambda time constant of the loop.

For details, see section 5 “Controller settings. Calculation of PID settings and filters” — Controller tuning panel —
Settings that provide optimal compensation for changes in the Setpoint tuning task (approximately page 48)

Valve Travel Index - Valve Travel Reduction Index.

Percentage improvement (i.e. reduction) at new settings in total control valve stem travel compared to current
settings. If the valve stroke increases with the new settings, including the PV filter, then the value of this index will be
negative.

Valve Reversal Index - The index for reducing the number of valve reverses.

Percentage improvement (i.e. reduction) at new settings in the expected number of control valve stem reversals
compared to current settings. If, with new settings, including the PV filter, the number of valve reversals increases, then
the value of this index will be negative.

Valve indices based on - Calculation of valve indices is performed according to the trends of the loop response in
the Control Loop Simulation simulation window to a disturbing action:

* Load - load jump

« Setpoint - change the task

* Noise - noise in the PV signal.

Control Loop Performance Evaluation Recommended Settings Window
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1. The dynamics of the valve are determined by the trend of the response of the circuit model to the load jump
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The window contains three sections with a graphical representation of the generalized performance of the circuit in
the form of linear indicators-columns of blue and red. The blue color refers to the current settings, while the red color
corresponds to the new recommended outline settings. The choice of sections is in the Options menu.

Section Performance and Robustness -Performance and Stability.

The higher the bars in this section, the better. Columns - performance indicators of the circuit are presented as a
percentage relative to the "optimal" performance, taken as 100%. The red column (new settings) is inversely proportional
to the current Safety factor (margin)

Factor:
Safety Factor New performance value
1 100%
2 50%
2.5 40%

Usually the user tries to optimize the contour so that all red bars are as high as possible. However, one must keep in
mind that 100% performance corresponds to the maximum speed of the circuit, and in this case, its stability is likely to
decrease.

The red bar is not affected by new manually entered values, while the blue bar is always set relative to the red bar
according to the calculated Performance Increase. If this indicator turns out to be negative, then the blue column will be
higher than the red one. In this case, under load disturbances, the current settings are likely to work better than the new
ones.

Columns-indicators of contour stability are set equal to the value of the smallest Closest distance on the graph in
the Robustness Plot window of contour stability (see approximately page 74).

Valve Duty Diagnostics section - Valve wear, indicators of the intensity of the valve, affecting its wear.

Valve Travel - Valve travel, the total distance traveled by the analyzed valve stem during the transient response
(loop response trend in the simulation window). It is found by summing the absolute (unsigned) amount of change in
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stem position in each test data acquisition cycle. A comparison of the red and blue columns shows the effect of the new
settings on the amount of movement and therefore the wear rate and valve life.

Valve Reversals - The number of valve reversals, the number of changes in the direction of movement of the valve
stem, corresponding to the trend of the loop response to a disturbance, presented in the “Control Loop Simulation”
simulation window. Usually, the more reverses, the faster the valve wears out.

Valve and circuit performance improvements

The Valve Travel Index, Valve Reversal Index, and Robustness Increase are generalized comparisons (percentages)
of the improvement in circuit performance from current settings to new settings.

For example, if the current valve stroke was 20, and with the new settings it became 10, then the valve life will be
doubled, that is, by 100%. The valve travel index will be 100%.

If the valve stroke was 20 at the current settings, and became 4 with the new settings, then the valve life will be 5
times longer, and its stroke index will be 400%.

The considered numerical indicators of the intensity of movements - the dynamics of the control valve, characterize
the wear rate and, consequently, the service life of the valve. They can also be viewed in the contour simulation window
in a special narrow display window on the right between the CO and PV trends. Nearby are two small arrow keys, with
which you can select the desired indicator from the list. The current values are blue and the new settings are red.

By comparing the current and new settings, you can estimate how quickly the valve will wear out. The smaller the
stroke and reverse, the less the valve will wear out.

The output signal of the CO regulator must first pass through the I/P pneumatic converter, then the valve
mechanism moves the stem. ExperTune finds stem movements by analyzing the CO signal and then uses them to
calculate the stroke and number of valve reversals. Only such movements and reverses are taken into account, which
change the position of the valve by an amount exceeding the dead zone of 0.1%.

Evaluation of the effectiveness of the recommended settings
Control Loop Performance Evaluation
2. The dynamics of the valve is determined by the trend of the reaction to the step change in the SP task
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Recommendation.

Valve wear can be reduced by using a PV filter or by changing the PID settings.
First, if your system allows, try adding a PV filter to the loop using the filter time recommended by ExperTune. If
this does not reduce valve wear sufficiently, consider modifying the regulator settings. In practice, there is always a trade-
off between "fast" settings, loop stability and valve wear. Then adjust the parameters P and 1. Generally, decreasing the

proportional gain P has a greater effect than decreasing the integral time constant 1.

To obtain minimum valve wear, select a Pl controller setting with a high Safety factor or a long response time. In
this case, the stability of the circuit will be good, and a compromise is achieved by worsening the response to load

disturbances and a change in the reference.

The intensity of valve movements The less movement and reversal occurs, the better for the valve. To get the best
analysis of valve dynamics, set the Control Loop Simulation Window to "Measurement Noise Response” so that the valve
performance matches the actual loop conditions. Compare valve wear rates at old and new settings. These numbers can
also characterize the efficiency of the PV filter.

Evaluation of the effectiveness of the recommended settings
Control Loop Performance Evaluation
3. Valve dynamics indicators are determined by the trend of the response of the circuit model to noise in the PV

signal
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Analysis of the relationship of time parameters in the control loop

The Control Loop Time Line Analysis window helps to understand and evaluate the ratio of the time parameters of
all components that determine the dynamic properties of the control loop (see figure). For optimal and stable operation of
the circuit, each of its time parameters must correspond to other dynamic characteristics of the circuit. For example, the
cycle of the regulator / controller (calculation of the PID algorithm) must always be less than the delay time (deadness) of
the Deadtime loop. If the regulator cycle is close to Deadtime, then reducing it will significantly improve the performance
of the circuit.
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For optimal loop performance, the values of the loop time characteristics should be located on the time axis in the
following order:

* Controller Cycle * Filter Time * Derivative Time Constant * Process Dead Time * Equivalent Process Dead
Time (in case of 2nd Order Process) * Integral Time Constant * Relative Loop Response RRT

The value of each of these parameters, if it is not equal to zero, is noted on the time axis in seconds in a logarithmic
scale. Therefore, the time of different components of the control loop can be easily compared. In this case, the integration
time constants (1) and differentiation (D) are taken from the “New” column of the new recommended settings on the
faceplate of this circuit.

For ease of comparison, the tuning parameters of the serial or parallel version of the PID algorithm formula
representation are converted to one equivalent structure of the “ideal” (ISA) PID algorithm (if your controller does not
already use the ISA version) and are presented in seconds.

In these units, the relationship must always be satisfied: “The time of differentiation is not greater than the time of
integration”, that is, D <= | . Otherwise, differentiation (or filter) starts to interfere with the action of integration. In some
rare cases of loops with two large lag links, applying a value of D > | can slightly improve the response of the loop to a
load disturbance, but at the expense of stability. ExperTune settings always give equivalent values D < I.
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The formulas for calculating the three variants of the PID algorithm are as follows:
* “Ideal” or ISA algorithm:

OUTPUT =K. [m:f) +4 fe(t)d(z) + D Efﬂ]

« Parallel algorithm:

OUTPUT = Ky [e(t)] + 4 [ e(t)d(t) + D,.d—f{iﬂ
o

* Sequential algorithm:
OUTPUT = K. [u[f} + —lLr_f'u[rjdnr]] [1 +D ﬁf?

where Kc, Kp — coefficient of proportionality (gain), I, Ip — integral coefficient, D, Dp — differential coefficient of
PID settings.

In the case of a second-order process (contains 2 lag links), the equivalent delay time is calculated and marked on
the time axis according to the formula:

Equivalent Dead Time = Dead Time + smaller of two lag time constants

To see the exact time value for a certain parameter, position the cursor at the desired location on the screen on the
mark of this parameter.

Timing evaluation

As mentioned above, the time parameters of the loop must be located on the time axis in a certain sequence. Where
possible, ExperTune monitors and evaluates the relative values of the time parameters and places colored bars with
messages in the appropriate places on the diagram (see figure). The color of the strip has the following meaning:

Green - all is well, OK Yellow - Attention, the performance of the circuit can be improved here Red - The
performance of the circuit can be significantly increased.

Sometimes there is not enough space on the colored bar for the full text of the evaluation message. In this case,
place the cursor on the text to read the full message. You can also stretch the image horizontally and vertically.

ExperTune checks and evaluates the following timing relationships:

1) Controller cycle versus loop dead time

2) Filter time PV compared to controller derivative time constant

3) Derivation time D versus integral time |

4) Filter time PV compared to process dead time or equivalent (for 2nd order processesO All evaluations are
performed only for non-zero parameter values
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8. PROBLEMS OF CONTOURS
Special tests, diagnostics and recommendations

HYSTERESIS

The control valve is the most typical and common source of hysteresis in a control loop, but not the only one.
Hysteresis may be present in mechanical connections and the like.

The hysteresis phenomenon occurs when the inertial "sticky" valve does not have time to respond to a change in
the direction of the pneumatic control signal and continues to move in the same direction for some time, although the
input signal has already changed to the opposite. In this case, the valve will not start to move back until the input signal
changes in the new direction by a certain amount in%, which is taken as the numerical value of the hysteresis.

ExpertTune recommendations

Hysteresis: If the system has hysteresis greater than 1% for valves with positioners or greater than 3% for valves
without positioners, then you should consider repairing or replacing the equipment to reduce the hysteresis and improve
regulation. Often, installing a valve positioner solves the problem.

Valve parameters: ExperTune believes that a well-designed process should have a process gain in the range of 0.5
to 3. If this is not the case for your process, then adjustments may be required: 1) valve size, 2) valve characteristics or 3)
Sensor range.

Noise level: An interference level of less than 2% is considered "normal”. However, the less PV noise, the better. If
the noise exceeds 2%, consider using a PV signal filter to reduce the interference.

To test for hysteresis, it is necessary in the manual mode of the controller to first collect a small part of the data on
the normal noise in the circuit, and then make several changes-jumps in the CO output signal: two steps in one direction
and one step in the other.

Steps must be greater than 1% of the CO range. If the noise at the output of the regulator is greater than 1%, the
hysteresis test program will take it as a test step. To prevent this from happening, average the CO signal between steps,
clearing it of noise.

Data collection should start at a steady state of the PV manipulated variable, which should then reach a steady state
after each subsequent step. Steps must be taken quickly in leaps, since the CO output must take a new value in no more
than 3 data reading intervals.

Test procedure.

1) Switch the regulator to manual mode, wait for the stable state of the regulated

variable PV and enable data collection (archiving).

2) Gather some data on the normal noise of the loop, and then quickly increase the output

CO regulator by 5%.

3) Wait for the PV to settle down and again quickly increase the CO output by 5%.

4) Wait again for PV to settle down and quickly reduce CO by 10%.

5) Wait for the PV to reach a stable state and turn off data collection.

6) In the Data Trend Window, use the Zoom in function to select the collected 3-step data and call the “Hysteresis
check” function by soft key or from the Options menu.
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ExperTune determines the hysteresis using the following procedure:

 Finds and marks each of the three steps of the CO regulator (in Manual mode) with a label c1, c2 and c3,
provided that the step-jump is greater than 1%. If there is a problem with some step, the program marks the last "good"
step. If there is noise at the output of the CO controller, the data is averaged to clear the trend sections between test steps
from the noise.

» From the initial test data collected with the loop stable, the program determines the loop noise band, which is
bounded above and below by magenta lines indicating the maximum and minimum of noise. Above or below the
inscription "noiseband" (noise band) is given.

* Finds and highlights in yellow the section on the trend that corresponds to the stable state of the contour after
each of the three test steps. At the same time, a straight purple line is drawn through each such area. If there is a problem
with the "zone of stability”, the program marks the last "good" area.

* Red vertical lines marked "p2" and "p3" are drawn between the three stability zones as shown in the figure above.

» The hysteresis value is calculated and displayed in %. If, however, no hysteresis can be found from the collected
data, an error message is issued.

“Manually Choose Areas for Hysteresis Check” option

This option can be used when an automated test has problems selecting suitable data patches in a CO or PV trend.
To check for hysteresis, you always need to manually make several changes to the controller output: 2 steps in one
direction and 1 step in the other. Before the first step, it is necessary to collect some data on the normal process noise in
open loop (Manual controller mode).

The option is selected in the Hysteresis Check menu of the Trend Window and allows you to manually select the
desired trend sections.

4 vertical lines appear in the Trends window, which you need to “drag” with the mouse to the “stable” sections of
the trends. The first line is placed in the stable zone close to the 1st change in CO, the next two lines are similarly placed
before the 2nd and 3rd steps, and the last line is placed after the 3rd step closer to the end of the trend.

The noise band is determined by the first stable data section - from the beginning of the trend to the 1st line.
ExperTune uses the CO and PV values at the points where the lines pass to perform a hysteresis check. Hysteresis, valve
and sensor performance calculations can be highly dependent on the location of these lines.

Oversized valve or sensor range too small?

In a flow control loop, the most likely reason why the process gain may be greater than 3 is that the valve is
oversized. Such a valve can significantly impair regulation.

Any valve or actuator is characterized by a resolution or amplitude of changes in the controlled value (range
ability), which determines how accurate the regulation will be. For example, an on/off valve has only two states and very
low resolution. A good control valve can have an amplitude of 100:1, so the output of the regulator can be set to within
1%. This means that the valve resolution is 1%. If the valve is oversized, then its useful operating amplitude is reduced.
With a process gain of 2, a control valve with a potential amplitude of 100:1 will have an actual amplitude of 50:1,
corresponding to a resolution of 2%.

If the valve size is oversized, it may turn out that the valve operates in the limit position, on the "saddle". For the
same reason, cyclical oscillations can occur in the circuit, since the control loop always oscillates, “walks” around the
equilibrium position within the valve resolution, or the valve can be on or near the “seat”.

The problem of a "large™ valve size can be solved by adjusting it or replacing the valve with a suitable size.
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The process gain can also be high if the valve characteristic is incorrect. It is possible that the ratio in this process
area is increased because the valve is linear and should be of the "equal percentage” type or vice versa.

Another reason for increased loop gain may be too small or narrow nominal range of the sensor. Here, to solve the
problem, you need to increase the range. Note that this case is rare, as users usually try to make the sensor have a larger
range.

Sensor rating too large or valve undersized?

In a flow control loop, the most likely reason why the process/loop gain may be less than 0.5 is that the PV sensor
range is too wide. Decreasing the range will increase the resolution of the PV measurement, equal to the smallest change
in PV that the system can detect. .

For example, a 12-bit analog-to-digital converter (ADC) has a resolution of 1/4096, or 0.02%. If the sensor is used
to measure temperature in the range from 1 to 4096 degF, then measurement and regulation are possible with an accuracy
of no better than 1 degF. However, if the temperature is measured from 100 to 500 degF with this sensor, then its
resolution will increase by a factor of 10 and will be 0.1 degF. Thus, by reducing the nominal range of the PV sensor to
match the actual operating range of the measured variable, the accuracy and quality of regulation can be improved.

An undersized valve may affect the safety of the facility as the range of travel may not be sufficient to control the
process. A possible solution to this problem is to “fit” the valve or replace it with a valve of the correct size.

In addition, the loop gain may be too low in a certain process area due to incorrect valve characteristics: the valve
is linear, but it should be of another type - “equal percentage” (equal percentage) or vice versa.

How to respond to the error message: "Each CO change must be at its final value in 3 samples"

When testing for hysteresis, the program controls the time of change of the signal at the output of the controller. If
the CO output changes too slowly or the signal is very noisy, the following options are recommended:

» Manually select data sections in the Trend Window for hysteresis calculations

* Re-acquire data.

* Edit the trend so that the CO output changes abruptly.

If the noise level at the controller output is unacceptable, use the averaging function to clean up the trend sections
between steps.

STICKING VALVE

The term "sticking" refers to the resistance to initiation of valve movement. Sticking or uneven, jerky motion is due
to too tight mounting, an incorrectly selected actuator, or a corroded valve stem. A very common defect is sticking on the
"seat", especially with tight-closing valves.

Due to sticking, the control valve does not immediately begin to move under the influence of air pressure and
eventually sets to the wrong position. Therefore sticking always results in cyclic fluctuations in the controlled process
variable.

For a control loop, sticking is a big problem. The controller makes the valve move until the process variable PV
reaches the setpoint SP, but due to sticking the valve will continue to move and the variable will go too far beyond the
setpoint. Therefore, the regulator will change the direction of movement of the valve to the opposite and everything will
repeat again. This limit cycle, when the valve gets stuck and then suddenly overshoots when the input signal changes, is
called an intermittent or jump cycle.

There is no general method to determine how much sticking is acceptable in a given circuit. It depends on the
specific circuit and the whole process. For many processes, 0.4% or 0.5% sticking is too much. Adhesion guarantees the
circuit cyclic oscillations and increased variability.

It is important to determine if there is sticking in the contour and to what extent. After that, it will be possible to
assess how this sticking is harmful (or destructive) to the entire technological process. Sticking is the most detrimental of
all possible valve problems. For example, hysteresis is, of course, an undesirable phenomenon, but usually it does not
become an entirely unsolvable problem. Another example is the non-linear characteristic of a valve, which can be
compensated for by means of a linearization function installed in the controller or valve positioner.

Typically, the degree of valve sticking during bench tests turns out to be greater than when working on an object in
a control loop, since there is no lubrication, vibration, “noise” on the bench, and also the force required by the valve to
overcome the resistance of the process product, which also affects the operation valves and sticking. The ExperTune
program allows you to measure and evaluate the degree of valve sticking (in %), for "on the bench™ and "work in the
circuit" modes.

Data collection for checking valve sticking

To check the circuit for valve sticking, it is necessary to make several test changes in the CO output signal in the
Manual mode of the regulator: one large step of 4% - 5% and then several small steps from 0.1% to 0.3%. All steps must
be in the same direction. Before the first step, it is necessary to collect some data on the stable operation of the open loop
(manual regulator mode) without jumps and transients.
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After each step, the PV variable must settle down and reach a steady state before the start of the next step, with at
least 30 seconds between steps. Steps must be taken quickly, abruptly.

The first big CO step is designed to overcome any possible hysteresis in the loop.

Note. The valve sticking test can be performed immediately following the hysteresis test. To do this, take a series
of small steps - changes (0.5%) of CO output in the same direction as the last CO jump in the hysteresis test.

Data Collection Procedure for Checking Valve Sticking

1. Set the regulator to manual operation, wait until the process (PV variable)

calm down and turn on the data collection and registration on the XT faceplate (key

2. Collect normal PV noise data for 45 seconds in a steady state loop, then rapidly increase the output of the CO
regulator by 5%.

3. Wait for the PV variable to settle down (wait at least 30 sec) and quickly increase the CO output by another
0.2%.

4. Repeat step 3 until PV changes (valve moves) after each step (see example below), then wait at least 30 seconds
and turn off data collection.

5. If necessary, in the Trend Window, select (Zoom in) the data of the steps taken and, of course, the initial section
with the data of the stable operation of the contour.

6. From the Options menu in the trend window, select Stiction check. The program will analyze the collected data
for the presence of valve sticking in the circuit.

IIpumep cOopa JaHHBIX AJI5l AMATHOCTUKY NPUIHNAHUSA KJIalaHa

= Hi=] 3
Zoom  Edit  Options  Help

2| @l larli] o] 2l o] 4] 4] B |

533 points
54 761 " b A e e
PY lllI.1..'‘-.'''.-lI''n|'‘'I"'‘|'II''‘''I\.-‘I'|'|'|.a1‘-\|'|I|,|"l.l'‘'‘I'“'l.'|''.nd,'n-.,,|'l,.l'|f''..I''1‘'1,l'‘'"'-.-11..,'"p...'..,1'‘'1'i''|,|.'._‘.'‘r“l,r.,I’-'-’i,l.l'l,--..-l"'t'..ll‘|,||"'. SR A
(Deg F)
4 5 E 5 | | | | | | | | |
- 20 40 60 80 100 120 140 160 180 200 220 240 260
61.2

o
(%)
55.641 80 100 120 140 160 180 200 220 240 260

732 | Time (seconds)

]Euum in. average. or edit your data here.

Analysis of collected data

Testing data analysis is performed in 2 stages and each uses its own separate page - the image in the Trends
window. First, on the 1st page, it is necessary to mark with a vertical line the time of the beginning of each step-change in
the output signal of the CO regulator. The program tries to do this automatically, but you may need to manually correct
and refine the location of these lines. If the CO signal has no noise, then it is likely that XTune itself will correctly set the
vertical lines.

The user can move (Move), add (Add) or delete (Delete) lines with the mouse. To select a point (coordinates along
the time axis) or a line, you need to place the cursor on this object and double-click the left button or simply click the
right button.
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When you have finished setting the vertical lines, click the Next button. It is recommended to expand the Trends
window to make it easier to work with the data.

Further, on the 2nd page, the program draws horizontal lines on the PV trend, corresponding to the average value
of the PV variable on each trend section between steps - changes in CO. As a result, each horizontal (stable) section of the
CO trend will correspond to a section of the PV trend marked first with a yellow and then with a red horizontal line. (see
picture below). The red line shows the average value of PV in this area, the yellow line extends the red line to the end
point of the previous red line. This makes it easier to notice changes in PV with small changes in CO, which in turn are
needed to detect and measure small sticking. When the valve moves the sticking field, the PV variable may change by a
very small amount. An indication of the average PV value will help to detect small changes (in response to a small CO
step) against the background of PV noise.

Adhesion test data analysis example - page 2
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As you can see in the figure, the software automatically placed 2 vertical lines on the trends to automatically mark
the CO values corresponding to the sticking zone of the valve. If necessary, you need to more accurately set these lines
manually. As a result, the first line should be on the “stable” section of the trend before the 1st small step of CO. It is
likely that XTune will set this line correctly. The second line should mark a stable section of the trend after a real change
in PV as a result of the next small step of CO. This second line marks the end of the sticking zone (see picture).

The difference between the value of the CO signal at this point and the value of CO before the first small step of
the test determines the amount of sticking. XTune converts it to a percentage of the regulator's full output range.

In fact, the actual amount of sticking is a little less, since the last small CO step that caused the PV to change still
had to move the valve stem to overcome the sticking.

How to deal with sticking.

1. The best way to get rid of sticking is to repair the valve or positioner. Verify that the valve or positioner is
supplied with the air pressure rating for which it was designed. For some modern pneumatic actuators, a force of the order
of 36.3kg (80Ib) is required. Check that the positioner is the correct size for the valve. If necessary, remove the
valve/positioner and repair it.

2. Provisional or partial measures. Below are some tricks and methods that should be considered as partial and
temporary. To really solve the problem, you need to eliminate the very cause of sticking. These measures are always a
compromise that will adversely affect the performance of the circuit or the life of the valve. Techniques that force the
valve to move more are likely to result in additional valve wear, and changing the optimal regulator settings will cause a
decrease in circuit performance. However, this may ultimately be better for the process than sticking cycling.

Adding Noise to the Regulator Output Constant movement can help combat sticky, jerky valve movement. In a
liquid material system, add a 300 Hz periodic signal with some derivative to the PID settings. This will add noise to the
signal at the output of the regulator. Positioner reset. Integration in the positioner, combined with sticking, causes the
valve to cyclically oscillate. If the positioner is a PID controller, use the derivative term, but do not use the integrating
action. In this case, the positioner will no longer be so accurate, but cyclic oscillations will disappear in it. The derivative
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will help keep the positioner in motion, possibly eliminating the jerky nature of valve movements (while accelerating
valve wear).

Using a PID Controller with an Integral Deadband The integral term of the controller output, combined with valve
sticking, causes the loop to oscillate. Use a variable integral PID controller. Set the "deadband" in the integral so that if
the PV-SP error is small enough, the integration is turned off, that is, if |Error|< k, then Integral = 0. This approach is
better than applying a deadband to the entire PID algorithm, as suggested below in the last paragraph.

Reconfiguring the PID controller. The integral component of the regulator, combined with valve sticking, causes
cyclic oscillations in the circuit. Remove the integral component, and the regulation will worsen, since a non-zero
residual deviation of PV from the SP reference will appear in the circuit at a constant SP (offset), but the cyclic
oscillations caused by integration will disappear.

Using a PID controller with a deadband Set a small deadband for the PID algorithm. If the error is small enough,
the controller considers the error to be zero, and the CO output does not change. It's generally bad practice to put a
deadband into the regulator, but it might help to combat valve sticking.

NONLINEAR LOOP

Many control loops are difficult to tune because they are non-linear. This means that the process gain (Process
Gain) changes depending on the value of PV or the output of the CO controller. If you do not use linearization, then you
will need to adjust the controller to the conditions when the transfer coefficient is maximum. As a result, for the rest of
the range, the settings will be "slow". Linearization of such loops will improve regulation, since the regulator will be
better tuned over the entire range.

If your process (PV variable) is cyclical at one end of the range and slow, inertial at the other end of the range, then
it is all due to non-linearity. By using a linearization block (ExperTune linearizer), it is possible to achieve the same
performance of the circuit over the entire range of the controlled variable PV, which will ensure optimal production of the
product and get rid of cyclical fluctuations (see example below).

Nonlinear contour before linearization
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Contour after installing the output linearizer
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There are two types of linearizers according to their place of installation in the control loop circuit: "input" and
"output” linearizers.

ExperTune provides creation and application of both output and input (pH) linearizers.

In most circuits, an “output” linearizer is used, which can be used with various non-linear control loops: flow rates,
temperature of the shell of chemical reactors, internal (secondary) circuits of cascades, and in general in any circuit where
the SP reference is a variable.

An output linearizer can be useful for almost all temperature, level and pressure control loops that directly control a
valve.

An "input" or pH linearizer is used to linearize the control loops of individual processes:

« an indicator of the concentration of hydrogen ions (hydrogen indicator pH);

» Temperatures of some distillation columns where the temperature profile curves sharply at the center of the curve.

* redox processes

To find out which version of the linearizer your circuit needs, you need to check the reaction of the circuit (for
example, to a change in reference) or its linearity. If the response varies with load or performance, then an output
linearizer is needed.

The remainder of the Guide discusses the output linearizer.

The output linearizer receives the signal from the regulator output and converts its value in such a way that the
loop remains linear over the entire control range. In this case, the circuit with a linearizer must ensure the stability and
optimal settings on the entire CO or PV scale. Testing the valve along with the rest of the process ensures that the XTune
linearizer will be a good match for the valve and process specifications. Testing only one valve without the rest of the
process does not guarantee this, as too much depends on other elements of the control loop.

As a result of the analysis of the collected data, ExperTune creates and offers the user, for use in the linearizer, a
linearization program written in one of the programming languages: FORTRAN, BASIC, C, Structured text or in the
form of a table of coordinates X, Y of the break points of a piecewise linear characteristic. You can then copy and paste
this program into any Windows application (for example, ProcessSuite 4-mation).

Steps to create an output linearizer.

1. Data collection for linearization.

2. Analysis of the characteristics of the process.

3. Choice of piecewise linear or hyperbolic linearization.

4. Choice of programming language.
5. Setting up a linearized controller.

Step 1. Collect and analyze data for linearization

To control the non-linearity, it is necessary to collect data on the stable operation of the circuit at several points in
the range of the controller output signal in Manual or Automatic mode.
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An example of testing a non-linear flow control loop - a non-linear process response (PV) to changes in the output
of the CO regulator in manual mode

Procedure:

* In manual mode, set the controller output to 5% of the CO range or

in Auto mode, set the SP reference to 5% of the PV scale

» Wait for the process to calm down and reach a steady state when PV and CO trends are both straight horizontal
lines (noise excluded)

* Increase CO output (or SP reference) by 15%.

* Wait again until the circuit calms down and reaches a stable state.

Repeat this procedure in increments of 15% until you reach 95%.

This will give 7 readings of "stable” CO and PV data at 5%, 20%, 35%, 50%, 65%, 80% and 95% of the controller
range.

Comment. In automatic mode, ensure that the minimum (0%) and maximum (100%) allowable values for the SP
reference are included in the test.
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From the Options menu, select Characterizer. Then select each stable section of the trend in turn, marking it with a
vertical line. Next, double-click or right-click and select Add.

87



22 Time data for: D-\WBATUMNE \trash.001

m fod plione Help
|New Loop =l
Build | Cancel| 1464 paints in fle
126.3 — ———
PV 5 _/-—-J
B0.311]| e
54.9 . a-"_[i“’f_ 1 1 1 1 I
20 40 [Right Click to Add or Delete Line]
75.45 — — .
Co : Vammm
57.83 || _;-——"—
2.‘ 35 2 "'-I._J.I_ | . o - | — | - Al
: 20 40 60 80 100 120
Time [zecondz]

Working with markers - vertical lines.

Add line (Add). Place the cursor on the stable section of the trend to be marked and right-click or double-click.

Select Add from the menu that appears.

The selected vertical line is highlighted with a dotted line.

Move line (Move). Place the cursor on the line, and the cursor will change to a double horizontal east-west arrow.

Press and hold the left mouse button and move the cursor along with the line.

Delete line (Delete). Place the cursor on the line, the cursor image will change to

double horizontal east-west arrow. After double-clicking or right-clicking, select Delete.

Step 2. Analysis of the characteristics of the process

The process characteristic is a plot of the controlled variable PV versus the control output to the valve. If the

guality of the collected data is good, then the characteristic shows how non-linear the process is.

100

i Output to Valve (final output)

100

Ousput 1o Vahve (inal output)

100

In this example, it can be seen that at different points in the range, the same changes in the valve control signal (1
and 2) cause different changes in PV: the process response in section 2 is much greater than the response in section 1.

The PV scale is shown in the figure on the left, while part of the graph or the entire area corresponding to the PV
range may be grayed out. Areas above and below the PV range are highlighted in white. The scale of CO values is shown

at the bottom (X coordinate).

In this step, XTune calculates and displays the minimum and maximum gain values of the Process Gain(PrG) and

their ratio.

A smaller coefficient corresponds to a smaller slope, a maximum coefficient corresponds to the largest slope, and
their ratio characterizes the degree of non-linearity of the contour.
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The ratio of the maximum coefficient to the minimum should not exceed the number 3, and preferably no more
than 2. If this ratio is greater than 3, then an output linearizer must be added to the circuit circuit (or modified existing).

As a result of the analysis of the characteristic of the process, XTune issues a message about the degree of non-
linearity of the contour and recommended measures:

Ratio value Message

Bad (bad data) Warning: Bad data - not suitable for linearization

1 to 1.5 The contour is almost linear

From 1.5 to 2.25 The contour is slightly non-linear

2.25 to 3 Linearization can have a noticeable effect or detune this contour

More than 3 Linearization of the contour is necessary or it will have to be detuned

Slops Eatio
bad

betwesn 1 and 1.5
betwesn 1.5 and 2,25
between 2. .25 and 3.
over 3

WARNING: Poor data — not appropriate for characterization

Loop iz almost linear

Loop i= =omewhat non-linear

Loop could benefit from characterization — OR detune this loop
Loop requires characterization or HUST be detuned

A split range control loop is a loop that controls two or more valves, switching from one to the other depending on
the value of the regulator output. Typically, switching occurs at 50% of the CO output scale. For example, up to 50% the
circuit cools with cold water or heat transfer oil, and above 50% it provides heating with steam, hot water or hot oil. Such
loops are usually very non-linear and an output linearizer is extremely useful for them.

Do not use an output linearizer with pH circuits - they require an "input" linearizer.

If the degree of non-linearity of the loop is 2 to 3 or more, the use of a linearizer will improve the performance of
the loop and be efficient.

—,/ ‘@ ————— .

_®___

b

Step 3: Building the Output Linearizer

After collecting process data and marking 5-10 stable sections in the Trend Window, using the Build button, you
can call up the Linearization Wizard, which will help you build a linearizer for your non-linear circuit.

First, you need to choose a variant of the linearizer, which is determined by the type of curve that approximates the
characteristic of the process:

* Piecewise Linear Fit — a piecewise linear curve, which is defined by pairs of coordinates X, Y of breakpoints.
This type is often used in industrial process control systems.

» Hyperbolic Fit - a hyperbolic linearizer that uses one hyperbolic formula, which allows you to build a linearizer
based on just one division block
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Piecewise linear linearizer.
The characteristic of the process in the linearizer is described by a piecewise linear curve consisting of several
segments. Initially, the user determines the number and coordinates of the linear segments, marking the breakpoints with

a red square marker, and the beginning and end of the entire curve (linearizer input signal range) with a blue square.
These markers can be easily added,

delete or move with the mouse after a "right™ or double click.

200 The right vertical axis

100 corresponds to the input signal of
the linearizer. Moving the blue
markers changes the lower or
upper limits of the range.
In this case, the left blue marker

Charact |always corresponds to the lower

T limit of the range

PV inpist
1]
0
1] Output toValve [final output)] 100

Adding a marker. Point the cursor (mouse) to the location of the new square marker, then double-click or right-
click and select Add.

Removing a marker. Select the desired square with the cursor, and the cursor type will be named. Further

double-click or right-click and select Delete.

Move the marker. Place the cursor on the desired square, and the cursor type will be named. Then press the left
mouse button and, holding it down, move the marker to a new location.

Automatic installation of markers. If you press the Avto Adjust key, XTune will try to position the red markers in
the best possible way. It then interpolates the line segments between the markers and adjusts their vertical position. The
user can move the markers on the X axis and call the Auto Adjust function again to reset them on the Y axis.

To improve the linearizer after Auto Adjust, you need to manually adjust the markers again.
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Hyperbolic Linearizer
This linearizer uses only one equation, which requires several arithmetic operations, including just one division, to
solve it:

Valve = CO /[L + (1-L)CO],
where CO = controller output, Valve = linearizer output, L = linearity parameter (constant).
Try moving the red or blue marker with the mouse. In this case, the hyperbola changes and at the same time the

current value of the linearity parameter L for this curve is displayed on the screen. Adjust the curve (and parameter L) so
that the hyperbola matches the process characteristic as much as possible, that is, it passes through all the crosses.

100
Comment. In this example, the top of
the linearizer curve is above the
maximum of the PV scale. This can be
changed in the Linearization Wizard

200 using the image stretch and shrink

Charact- options.

ENzer

input

Fh.lj'
X
1]
0
0 (ustput ba W alve [final output] 100

Tuning the linearizer by changing the parameter L.

One of the advantages of the hyperbolic linearizer is that it can be "tuned" in place, directly on the control object by
"selecting" the parameter L. There is no need to monitor the entire characteristic of the process - if the circuit generates
oscillations at at low CO values, increase L, if fluctuations occur in the upper part of the CO range, decrease L. Note:
after changing the parameter L, the regulator gain must be adjusted.

Adjustment of the proportionality factor (gain) of the controller after changes in L.

As a rule, even before linearization, the controller is already set to stabilize the loop at the value of the CO output,
when the gain of the loop (closed circuit, including the process) is maximum. Therefore, if the linearizer is used correctly,
it reduces the loop gain at this CO output value and allows you to increase the proportional gain of the controller in the
same proportion (in the APACS + / QUADLOG system it is referred to as PG). The linearizer gain at 0% CO is 1/L, and
at 100% CO it is L. Therefore, if L<1 is set to eliminate fluctuations at 100% CO, then the proportional gain of the
controller can be increased by multiplying by the number 1/ L. Conversely, if L > 1 is set, then P can be increased by L
times.

Control systems with CALC computing units that work with variables and constants on a scale of 0% -
100% (0 - 1).
In this case, the Hyperbolic Linearizer needs 2 CALC blocks.
The first block calculates the intermediate variable Z:
Z=1-X,where | =100 The following formula depends on the value of parameter L.:
if L<1then
Y =X/(Z* G+ X)where G =100L if L > 1 then
Y =X/(Z/G + X)where G =100/L

Working with the Linearization Wizard
Ability to stretch or shrink the linearizer image.

The options listed below become available after selecting the Finish button in the Linearization
Wizard.Expand Top or Bottom — Stretch the top or bottom of the image.

The image size will increase so that you can see and move the blue markers - the ends of the linearizer curve.

Shrink Top or Bottom - Shrink the top or bottom of the image.

These keys appear if the image has been stretched before. Click the mouse for more information.
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Shrink All or Expand All - Shrink or stretch everything.

With a single click of this key, you can compress or expand the entire linearizer image. The key appears in the
center if the image was previously stretched, and works in toggle mode.

Notes. 1. The output of the controller and the output of the linearizer are different variables. For example, if the
final control is a valve, then if the controller output is 50%, the valve (after the linearizer) will not be in the 50% position.

2. If the PID controller uses reset-feedback feedback (Foxborough, Moore Products) to suppress overshoot, and
you have installed a linearizer in the loop circuit before the Auto/manual control station (apparently, this means an
autonomous controller outside the DCS) , then for feedback it is necessary to use an inverse linearizer.

Step 4. Selecting the Linearizer Programming Language

The possible programming languages for the linearizer are presented for selection in the Linearization Wizard
window at the top right. These are FORTRAN, Basic, C, Structured Text, and in the case of a piecewise linear linearizer,
also a table of coordinates X, Y of the points of definition of linear segments (X-Y pair list). In the graph, the X linearizer
input is the right vertical axis, and the linearizer output to control the valve = the horizontal Y axis.

ExperTune Characterizer ﬂ:

Language for Charactenzer Code
i~ FORTRAN = ¥ pair list
asic ~ Struciured text

_|_

100 + Fc

'-.E{Id_ﬂ fo use

=Y + REM CO is the controller output ]
REM (characterizer input).
-+ REM Valve is the characterizer output.
+ I (CO <5.263) Then

£ Vahe {46590 + 0
M3 T Elself (COTT9 74) Then

Vahe = 1.425*C0 + 16.97
Elself (CO €55.26) Then

Vahwe = 0.8366*C0 + 2859
Else
0 Outputio Valve (final outpuf) 100 Valve = 05627°CO + 43.73

. - End i
Low Process Gain Compensation =]

large linearizer coefficient G Code | . I

The linearizer program in the Wizard can be edited, copied or deleted. When copying and deleting the text of the
program is written to the Windows clipboard, from where it can be pasted into any Windows application.

ExperTune Characterizer _I

—Language for Characterizer Code
" FORTRAN " XY pair list
C +)Basic " Stuctured text
100 P

+ C

—Code to use

-+ REM CO is the controller output ;J
REM (characterizer input).
3+ REM Valve is the characterizer output.
If (CO <5.263) Then
63 Valve = 465*CO + 0
0| + + Elself (CO <19.74) Then
Valve = 1.425*C0O + 16.97

Elself (CO <55.26) Then

Valve 0.8366%CO + 28.59

[Else
0 Output to Valve (final output) 100 Er;\gallfve ’CO +43.03
Compensation for high process gain =
Process Gain Create Code | Copy |
small linearizer coefficient -
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Step 5 Adjusting the controller after linearization

XTune uses the collected data to perform all of its functions - analysis, modeling and contour tuning. These data
must be identical to those that the regulator itself “sees”.

For the PV manipulated variable, always use the data that the controller uses for its PV. For CO, always use the
data directly from the regulator output. (See figure below)

Set Paint
Characterizer Output
Operator Characterizer
Set Point f—- Controller ||
Set Point PID Controller [
Controller PV ’7
Operator PV ——————— r
_ PV to use for CO to use for
PV Characterizer tuning data tuning data

When using an output linearizer for data acquisition, always use the signal directly at the output of the regulator,
not at the output of the linearizer.

In the case of a linearizer input pH, always use a linearized signal, i.e. PV and SP signals at the output of the
linearizer (at the input of the controller).

CONTOUR ASYMMETRY

Loop asymmetry is expressed as the dependence of the reaction of the process (load) on the direction of change in
the CO output: plus or minus, increase or decrease, with the same amount of change.

After the test for non-linearity, in order to check the asymmetry, in the manual mode of the regulator (open loop) it
is necessary to perform several of the same steps that were taken in the non-linearity test, but in the opposite direction.

Analysis. Compare the obtained PID settings or the mathematical models of the process presented in the Process
Model simulation window. Does the reaction of the process differ when CO changes up and down?

If the response is different, is it possible to eliminate or reduce this difference? If the situation cannot be corrected,
then more conservative settings should be used.
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INTEGRATING CONTOURS

Data acquisition for integrating circuits

Some loops are not capable of self-regulating because they contain an integrator, or there may be a large
capacitance in the loop. Such technological processes after a manual jump at the output of the regulator for a long and
very long time (perhaps never) can reach a stable state.

Examples are control loops:

* liquid product level (in most cases)

» composition of reagents (composition) and temperature of distillation columns and chemical reactors with a
stirrer

* extruder/press temperatures

* gas pressure (in some cases)

« digital mixing systems with volume control

There are 2 methods for collecting data for integrating circuits.

Method 1 - Steady state. Use the standard data collection procedure for loop tuning described above in the relevant
section, in either Automatic or Manual mode of the regulator. The ExperTune program is designed to calculate the
optimal settings, including integrating circuits. However, it may be very difficult in such a circuit to achieve the steady
state required for correct data acquisition. Use the following guidelines for this.

Recommendation 1. Automatic mode.

For a new circuit or a circuit with cyclical fluctuations, we recommend collecting data in automatic mode when the
controller is set to proportional control only, that is, without integral and differential components. For stable regulation,
set the controller proportional gain (PG,P) to 0.5. If the integration time constant (I, TI) is measured in time/repeat units
(e.g. min/repeat), then set this parameter to the maximum possible value (in APACS+/QUADLOG TImax = 4000.0
min/rep). Without integration, the circuit quickly comes to a "stable" state. If the rep/time inverse unit is used, then set Tl
=0.

After that, collect data with a change in the SP task and be sure to comply with all requirements.

Recommendation 2. Manual mode.

To set up the integrating circuit in manual mode, we recommend the "quick" test described above in this manual.
The test must begin and end with a stable state of the variables PV and CO.

If these recommendations do not fit or cannot help, use the second method.

Method 2 - Constant slope of the trend. If you are unable to achieve a stable loop condition in either manual or
automatic mode, use the method described in this section.

The idea behind this method is to manually collect data by changing the output of the CO controller in a similar
way to a "quick" test, and then use XTune to analyze the values of the derivative of the controlled variable PV.

A change in CO output results in a change in the slope of the PV trend, that is, the rate of change of the controlled
variable PV. Do not change CO until the slope of the PV trend is constant, that is, the derivative of PV is at a constant
value. Then change the CO and again wait until the new constant slope of the PV trend is established. See the picture
below
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After manually collecting data, press the “d/dt” key in the Trend Window or select Integrating loop from the
Options menu. In this case, the circuit is defined as "integrating”, and the XTune program will use the integrating process
as a mathematical model of the technological process - the load of the circuit. The wizard for setting up integrating
circuits is called up on the screen.

Integrating Loop Wizard

To tune and analyze the integrating loop, XTune calculates the derivative, that is, it differentiates the signal of the
controlled variable PV. In addition, a filter must be added to suppress excessive PV signal noise. Choose as small
(narrow) a filter as possible. However, it must be wider than twice the collection interval. By default, the filter time
constant is set to 4 acquisition intervals. To try different filters, use the Test button on the “Process variable filtering”
filter setting panel.

The following figure shows the same collected data, but after differentiation.
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Data after differentiation can be processed and analyzed normally, including calculation of PID settings, statistical
analysis, hysteresis check, valve sticking, etc.

To adjust the PID controller using the converted data, find and select in the Trend Window using the Zoom In
option a suitable zone, which includes trend sections with a stable state of the differentiated variable PV before and after
changing the output of the CO controller (see the figure below).
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LEVEL CONTROL

There are two main options for level control in a process flow diagram with a liquid product reservoir and inlet
and outlet flows:

1. You need normal precise level control according to the set SP task, your tank is a process tank, not a "buffer"”
tank. In this case, simply collect data for loop tuning and call the function for calculating the optimal PID settings
(PID Tuner). The fastest way to collect data for a level controller is in automatic mode, set to pure proportional
control without integral or derivative action. See also the Data Acquisition for Integrating Loops section.

2. You need to stabilize one of the flows, for example, the outlet, and the other flow and the level of the product L
in the tank can change, but without overfilling or emptying the tank. In this case, the reservoir acts as a "buffer",
which smooths out random disturbances, regulator load surges, stabilizing the regulated inlet or outlet flow. The
figure below shows a circuit for stabilizing the output flow with an unregulated input flow. For maximum
efficiency of the buffer tank, the level of the product in it must change, “float”. Then the regulated flow is much
less dependent on load surges and other, unstable flow. This scheme is called Averaging level control (Smoothing
or “buffer” level control). In this scheme, there is no optimal value of L and set by the technology of setting for
the level.

Buffer (smoothing) level control

If your tank is designed to provide a more consistent flow rate (flow) in the next section or process step, then you
may not need optimal or “tight” level control. In this case, you control the output stream, and the input stream can
change. The purpose of this "buffer" capacity is to absorb, dampen changes in the input flow and smooth and
stabilize the output flow as much as possible, but without overflowing or emptying the tank.
Regulator setting recommendation:
Use a proportional (P) controller without integral and differential components
1. Set the target SP equal to the minimum allowable level Lmin and designate it for process operators as the "lower
limit". Depending on the flow, the level in the tank will change (drift), and the name “target” may confuse operators, as
this is actually the lower limit.
2. If your controller uses the Proportional gain (PG) as its tuning parameter, set its value to:
100/[ (maximum allowable level in %) - (minimum allowable level in %)]
If the Proportional Band (PB) is used, then PB = 100/PG.
4. Set parameter Bias (offset) = 0
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The formula for PG assumes that the controller output is measured in %. With PG=1 (PB=100) a 10% level change
causes a 10% change in the CO controller output.

Such a regulator can also be used in a cascade control scheme as a leading (primary) regulator.

bt unregulated Scheme ot "smoothing" level control with
ow buffer capacity
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In such a system, at a high flow rate (flow rate), the level in the reservoir L will be high, since it is more likely that
the next disturbance will be in the direction of decreasing flow. Conversely, if the flow rate is low, the level L will be
low, since in this case the next change is likely to increase the flow.

If you need this type of regulation, use the XTune Wizards.

Buffer Level Master

ExperTune has a dedicated "Buffer Level Control Wizard" that guides the user through the entire level control
setup procedure. The wizard is called in the XTune (PID Tuner) window from the Options-Level wizard options menu.

First you need to decide what the tank is for and what type of level control you need. "Strict" level control
according to the SP target? Or should the reservoir dampen changes in flow?

If the task of the tank is to provide a more stable flow rate for the next technological operation or apparatus, then
you need buffer regulation, and to continue working, select the item "As a surge to smooth flow vessel upsets” (As a
buffer tank to smooth out flow surges) .

Otherwise, you do not need this Wizard, see option 1 in the previous paragraph.

The Buffer Adjustment Wizard provides several varieties (types) of such adjustment. When working with the
Wizard, windows are sequentially displayed on the screen in which the user makes a choice or enters additional
information. Below are listed and described the main windows that are sufficient to perform the calculation procedure and
adjust the controller.

First, the “Type of Averaging Level Control” window is displayed with information to help you further reasonably
select the type of buffer control.

Type of Averaging Level Control - About the type of buffer level control

While "buffer" use of the tank is useful and desirable, most process operators would like the level controller to
have the SP controller setpoint present and the level to tend to return to that value. This requires an integral action of the
controller.

Advantages of using the integral term and setting the SP for the level:

 Operators - technologists, if they are not specifically retrained, it is more convenient to work with a level that
returns to the set task.

* It is desirable that in the event of equipment failure, such as a pump shutdown, there is some time to spare.

Disadvantages of using the integral component:

* The volume of the tank that can be used as a buffer is reduced. For example, if the flow rate was at its maximum
and the SP reference and level are 50%, then in the event of a disturbance causing a decrease in flow, the system has only
half of the tank to compensate for this disturbance.

« Integral action circuit is more prone to cycling

Averaging Level Control with no Integral action
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Only proportional control is selected. In this window, XTune will calculate the proportional gain P,PG for your
controller.

Enter values in % for the upper and lower limits of the product level in the tank. Based on these values, depending
on the type of controller or system, the proportional gain / gain (Gain) or Proportional Band (PB) is calculated, with
PB=100/PG.

A simple calculation shows that the proportional band PB of the controller should be equal to the difference
between the upper and lower level limits. Then the movement of the valve from fully open to fully closed corresponds to
the full range of allowable level change between the two limits.

The integral and differential components of the controller must not be used.

Set the SP value to match the entered low level limit.

For more information on this topic, see the Buffer Level Control section above.

Averaging Level Control with Integral action - Buffer level control with integral action. Calculation P.

You have chosen the option with an integral component, as a result of which, after the disturbance, the level will
slowly return to the SP task. This window calculates the proportional gain setting. Further, in the following windows, the
integral component will be determined.

The proportionality factor depends on the parameters of the buffer tank and the magnitude of flow disturbances to
be compensated. Enter the following details:

Range of Manipulated flow: Enter the maximum range of manipulated flow in engineering units.

* In cascade. Often the output of a level controller is connected in cascade to a flow controller. In this case, enter
the maximum range of the flow controller.

« In a single circuit. If there is no cascade and the level controller output goes directly to the valve, enter a value
equal to 1.3 of the valve's design flow.

Distance from setpoint to nearest limit. The difference between the SP reference and the nearest (upper or lower)
level limit, expressed as % level.

Normally expected flow usage. Normally expected amount of flow disturbance in engineering units of the flow
scale. Check that the flow units are correct. They are used further to calculate the integral component.

Vessel volume known? Do you know the volume of the tank?

The value of the integral component for buffer level control depends on the filling time of the tank, that is, on its
volume. If the volume is known, select “Yes” and enter this value in the next window. If not, the program will tell you
how to measure it.

Enter vessel volume. Enter the tank volume.

Enter the buffer volume of the tank between the level taps. ExperTune uses this volume value and the previously
entered value of the possible change (perturbation) of the flow rate to calculate the integral component.

Verify that the unit of measure for the tank volume is correct. The program compares them with the flow units in
the previous window. If there is a discrepancy, a warning is issued, but if necessary, the program will convert volume
units. The program then calculates the integral action parameter in the units used by your regulator.

Measure vessel volume. Measure the volume of the tank.

To start the measurement, it is necessary to set up the system so that the level in the tank does not change, while the
level controller must be in manual mode. To achieve this, it may be necessary to manually change the controller output up
and down. Then, in this stable state, we change the flow rate by a known value. By measuring the time it took for the
resulting level change, the program calculates the volume of the tank and then the desired setting parameter for the
integral action of the controller.

Level measurement procedure.

1. With the level loop stable, place the regulator in manual mode. In the case of a cascade control scheme, turn off
the cascade and set the secondary (internal) flow control loop to manual mode. Record the initial flow and level values.

2. Change the flow valve control signal by about 5%. In a cascaded circuit, this will be the output of the secondary
flow controller. In a single loop circuit, this would be the output of the level control.

3. Wait for the level to change by approximately 5% and record the new flow and level values and the elapsed time.
To avoid problems with the process, return the flow valve to its original position and place the circuit (or cascade circuits)
back into automatic mode.

In the same window, enter the results of 5 such measurements in the fields provided for this. ExperTune first
calculates the tank volume. If the volume reading does not look correct, check the measurements taken and the
engineering units of the flow rate. In case of incorrect flow units, go back to the controller proportional gain calculation
window and change the flow unit.
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ExperTune uses the found value of the volume and the entered value of the possible change (perturbation) of the
flow rate to calculate the recommended parameter of the integral component of the controller.

This parameter will be presented in the units accepted in your regulator. For an APACS+/QUADLOG system, this
is the integration time constant T1 (denoted | in ExperTune), measured in units of min/repeat (min/repeat)

Level as a Surge vessel.. Level as a buffer tank.

The program shows the recommended settings for Proportional (P) and Integral (1) action for buffer level control
by your circuit. In this case, it is always necessary that the differential component is completely absent (D = 0).

The recommended value of the parameter | = 0 means no integral component. In some types of controllers that use
time units for measuring | - seconds or minutes, to exclude the integral action, on the contrary, it is necessary to enter a
very large number (in the APACS +/ QUADLOG system, the value TImax = 4000 min).

REACTING PROCESSES
In processes with the reverse (opposite) reaction of the Inverse Response Process, when the output of the CO
controller changes, the controlled variable PV begins to move “incorrectly” - in the opposite direction from the SP

reference, not as the controller sets (see figure below). These processes are also called "shrink-swell" processes.

The option to configure the control loop for such a process is called up in the Edit Setup editing window:
Advanced - Loop Setup... - Advanced- Inverse response process.
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A backlash process is a process that has a lead that is "ahead" of the input signal and has a negative Lead time. In
practice, this type of circuit usually also has an integrator - an integrator or a large delay time Lag time. In ExperTune, the
Inverse Response Process option assumes that the process has the following properties: a negative Lead time, an
integrator link (or a large Lag time), as well as a lag link and Dead time. These processes are 2nd order processes.

Two examples of such processes are:

* Level control in the boiler drum

* Product level control at the bottom of the distillation column

Use this option only if you are sure that you are dealing with a process of this type.
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If the “Process with feedback’ option is selected, the program analyzes the data and finds the process model on the
assumption that it includes the lead, lag and integrator links, automatically determines the “negative” surge parameter
(lead) and the integration time. The settings obtained by the PID program will be specifically oriented to this type of
process.

9. FORMING THE REPORT

For each control loop, ExperTune creates a detailed sample report with the results of the analysis and tuning of the
loop. If there are any problems with the contour later, you can always use this report for comparison.

The report generation function can be called from the options menu in the faceplate window: Options - Tuning
Report or from the Data Trends window "Time Data for ...": Options - Report - Full Tuning Report (Full report).

In addition, all ExperTune windows have an Add to Report item in the Options menu.

After adding new data to the report, you must wait for this operation to complete (the hourglass icon should
disappear), without loading the computer with anything else. After the report is created, all its fields must be updated. To
do this, in the menu Edit (Edit) MS Word, select Select All (Select all) and press the F9 key.

File - report template

ExperTune creates reports in MS Word 97 or higher, so report files are .doc files. Reports are created on the basis
of a common standard .doc template file that contains an "empty" report structure. By default, this file is located in the
ExperTune/Common folder. In the Advanced Options window - in the Report tab, the user can select a different folder
and a different file for the report template (see figure below). The window is called from the start window of ExperTune
through the options menu: Options-Advanced.

There can be several report templates, for example, for different categories of control loops.

The user can edit the report template according to the customer's requirements.

The first time (for a given loop) a report function is called, such as Add to report, ExperTune copies the
LoopReport.doc file to your folder where

.tun files and archive files of this circuit. The report file gets the same root name as the mentioned files plus the
.doc extension. If you have already called up a report, the program asks if you want to use the existing report or replace it
with a new template.
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Report generation method

Reports are created using bookmarks in a Word document. ExperTune program adds the necessary information to
the place of these bookmarks in the report. Each block of information in the report template has its own tab. Three
categories of tabs are used: Graph(Graphics), Picture(Figure) and Text(Text) for the three types of control loop data
blocks. Each block of information placed on a bookmark begins with text indicating the block’s type: Graph, Picture, or
Text.

graph

The "Graph™ type tab contains a Word Picture graphic object designed to place an image of the ExperTune window
with trend graphs (such as the Data Trends Window "Time data for ..." or the Contour Stability Graph "Robustness plot™).
The bookmark contains only one such object and nothing else.

picture

Bookmarks of the "Picture” type are intended for windows and panels with numerical and textual information and
dialog tools (calling and entering data, selecting an option in the list, etc.), but without graphic images-trends. These tabs
contain a single Word Picture object that defines the size and position of the corresponding Picture information block. An
example is the Statistical Analysis dialog box.

Text

Bookmarks that begin with the word "Text" contain text that is replaced by the program when generating a report
for a particular contour. The user cannot create their own bookmarks of this type.

The table below shows the prefixes/prefixes (the beginning of the name) of the bookmarks used by ExperTune to
include various blocks of contour information in the report.

(Bookmark Prefix)
Graphs:
Time data for - Graph_TimeDataFor
Control Loop Simulation Graph_Simulation
Process Frequency Response Graph_FrequencyResponse
Robustness Plot Graph_Robustness
Power Spectral Density Graph_PowerSpectral
Characterizer Graph_Characterizer
Correlation Graph_Correlation
Pictures:
Process Model Picture_Model
PID Tuning Grid — Picture_PIDGrid
Loop Summary Table Picture_LoopSummaryTable
Statistical Analysis — Picture_Statistics
Text:
PID Tuning Text_PID
Characterizer Text_Linearity
Hysteresis Check Text_Hysteresis
Sample Interval For Tuning Text_Samplelnterval
Loop Notes Text PID_Notes

When ExperTune receives a command to add information to a report, it looks for a bookmark in the report.

with the corresponding name. If there are two or more matching bookmarks for information such as Graph and
Picture, the program displays a message and asks the user to select a bookmark. Any bookmarked object can be moved
and resized. You can also add your own Graph and Picture bookmarks, but you cannot add your own Text bookmarks.

Note. Do not remove bookmarks from the document template, otherwise this part of the report will not work.

You cannot change existing bookmark names.

Additional features

ExperTune allows you to include additional images and texts in the report in the form of the following special
Additions:
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Hysteresis check

If the hysteresis check function is called in the “Time data for...” Data Trend Window with good test data quality,
a dialog box appears where you can select Options > Add To Report. The following items will be included in the report:

Statistical analysis

If you call Statistical Analysis in the “Time data for...” Trend Window, a dialog box appears where you can select
Options > Add To Report. The report will include the following data:

* The Statistical Analysis window is placed in a tab with the Picture_Statistics prefix, while the user selects one of
two tabs: Picture_Statistics_Before (Statistics before... contour optimization - old settings) or Picture_Statistics_After
(Statistics after... optimization - new settings)

» The Test Data Trends window is placed on one of two tabs: Graph_TimeDataFor_Before_Statistics (Trends
corresponding to statistics before optimization) or Graph_TimeDataFor_After_Statistics (Trends corresponding to
statistics after contour optimization).

XY dependency plot

The XY plot window is placed in a tab with the Graph_XYPlot prefix.

Changing a report template by a user

The standard ExperTune report template can be modified and edited to suit a particular firm, individual circuit, or
circuit category. For example, if there are several types of contours, then you can make a separate template for each such
group.

Reports are created using bookmarks in a Word document. To add your own bookmarks to Word, first identify the
object for which you want to create a bookmark, and then in the Word environment, select the menu Insert (Insert) >
Bookmark (bookmark). Next, use the bookmark naming conventions described above in the Report Generation Method
section.

Bookmarks for information objects of the “Graph” and “Picture” types should contain only one window with a
graphic image or one dialog panel, respectively. For these objects, ExperTune will use the dimensions specified by the
user.

The text bookmark can contain any number of characters.

Two macros are included in the Word document to help the user work with his bookmarks:
* DeleteBookMarkComments

This macro removes comments starting with the text "BookMark: " It must be run before the other
"AddCommentsToBookmarks™ macro.

» AddCommentsToBookmarks

This macro adds comments to all bookmarks in your document, with each added comment starting with the text
"BookMark: ". In order for comments to work in Word as "pop-up" screen tips, select the menu Tools (Tools) > Options
(Options), then you need to click the tab View (View) and select "Pop-up Tips".

To run a macro in Word, select Tools > Macro > Macros (Service-Macro-Macros).

Since reports contain macros and a Visial Basic (VBA) program, when you open a report template or report in
Word using the File > Open menu, Word may display a security warning message: "The document contains macros in
which there may be viruses that are harmful to your computer ... . Click the Enable Macros button to continue working.

Update fields (MS Word)
After creating the report, you need to update all the fields in the document. To do this, select Edit - Select All (or
press Ctrl + A), then press the F9 key.

Appendix: Sample Report - file gfic001.doc

An incomplete report example gives an idea of the ExperTune information blocks, tabs and structure of the report
template.
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	Zoom Back to Previous – undo the result of the previous Zoom In command (you can only go back one step)
	Average – Averaging part of the data in the Trends window. The function is called from the Edit menu
	About the method of calculating PID settings by ExperTune
	Terms and Definitions
	ExperTune evaluates the quality of the initial data by the amplitude (frequency response) and phase (PFC) frequency responses of your process (Bode plots), and this assessment shows how close the mathematical model found by the program coincides with ...
	The frequency response, on which both curves: AFC and PFC - amplitude and phase, gradually decrease with increasing frequency, gives the best indicator of data quality. The better the source data, the better the frequency response.
	In general, double-clicking or right-clicking in the PivotTable window allows you to perform the following functions:
	• Copy the values of parameters P,I,D and F to the column New
	• View archive file data
	• Edit comments
	• Add Table to MS Word Report
	• Copy the window to the clipboard as a .bmp image file, from where it can be pasted into any document
	• Double-clicking in the area of the first three columns automatically opens the window for viewing the data of the selected archive file.
	6. ANALYSIS OF THE DATA OF THE STABLE OPERATION OF THE LOOP
	This type of analysis is used to investigate the normal operation of a loop in a stable state with the SP setpoint unchanged.
	Note. For a number of analysis tasks, such as statistical and frequency analysis of the contour, histogram, and others, information is needed on the stable operation of the contour without jumps and transients. Data collection for this case is differe...
	• When the loop is stable, collect data again specifically for analysis using a semi-automated procedure with manual data acquisition on and off.
	• Using the Zoom In option, in the Trends Window, edit the information of the archive file of one of the previously performed tests of this circuit, selecting for analysis the desired section of data on the stable operation of the circuit.
	Collect data during normal stable closed loop operation (no spikes or transients) before and after changing settings.
	Using the "Statistical Analysis" option in the Trend Window, call up the statistics window and see how the quality of the regulation improves with the new loop settings. Compare the statistics before and after.
	Comment:
	1. All statistical calculations are based on the data presented in the Trend Window, and these data can be edited, including using the Zoom in function. Therefore, care must be taken to ensure that the data are always comparable.
	2. The volume of collected data should be sufficient for the reliability of the results of the analysis.
	The results of the statistical analysis of the contour are presented in tabular form in a special window "Statistical Analysis", which is called from the Trend Window. The table shows PV statistics: mean value (Mean), standard deviation (Standard devi...
	The option to configure the control loop for such a process is called up in the Edit Setup editing window: Advanced - Loop Setup… - Advanced- Inverse response process.




